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Introduction

This project will provide you with the background information, knowledge and
understanding needed to use Pro|ENGINEER to design, assemble and simulate a virtual
robot. While the context used for these materials is the FIRST Tech Challenge
competition, teams entering other robotics competitions including FIRST Robotics
Challenge should also find the exercises useful.

FIRST

FIRST (For Inspiration and Recognition of Science and Technology) was founded by
inventor Dean Kamen to inspire an appreciation of science and technology in young
people. Based in Manchester, the not-for-profit organization designs accessible,
innovative programs to build self-confidence, knowledge and life skills while motivating
young people to pursue opportunities in science, technology, engineering and math
(STEM).

FIRST Tech’ Challenge

The FIRST Tech Challenge (FTC) offers high school students the traditional challenge of
a FIRST competition, but with a more accessible and affordable robotics kit.

e Design, build and program robots

e Use a modular robotics platform

Apply real-world math and science concepts

Develop problem-solving, organizational and team-building skills
Compete and cooperate in alliances at tournaments

Qualify for scholarship funds

FTC makes it easy and fun to create and test innovative designs and explore robotics
concepts.

FIRST Tech Challenge — Robot design

Full details on the current FIRST Tech Challenge can be found on the official FIRST web
site at: http://www.usfirst.org/roboticsprograms/ftc/default.aspx?id=968

Prior experience

The techniques in this document range from introductory to advanced. Itis assumed you
have completed the introductory course in Pro|[ENGINEER and are familiar with part
modeling and simple assembly. Any intermediate and advanced techniques will be taught
step by step with screen snapshots and tools fully illustrated.

Teams wanting to improve their skills with Pro|ENGINEER can access comprehensive
web-based training resources at http://first.ptculms.com. Team members can register and
access training courses specific to modeling, assembly, detailing and mechanisms.

This will help strengthen their skills and should be used in parallel to this document



http://www.usfirst.org/roboticsprograms/ftc/default.aspx?id=968
http://first.ptculms.com/

% Note: You should keep the Quick Reference document close whenever you are
using Pro|[ENGINEER. It lists most of the toolbars, navigation and mouse operations
in an easy to find format. This is linked from the home page in the internal browser.

Briefing one — CAD and PLM

Engineering and technical teams generate much of an organizations’ most valuable
intellectual property, including customer requirements, engineering calculations, detailed
CAD designs, and product documentation. To work efficiently this information must be
shared with other departments but also protected. Managing this and other related
information can be very difficult.

PTC can help with Product Development Systems (PDS) which offer a number of linked
functions including;

1. Create product information

Communicate product information to different audiences
Collaborate regardless of location

Control product development processes

a bk~ 0N

Configure product content

Procurement Manvulacturing

Engineering o s { PDS ot Service

Marketing Sales

At the heart of a PLM system is a database or vault containing all the information related to
a product.

PTC provides all FTC teams with access to Windchill ProjectLink or Product Point to help
you develop your robot designs.

If your team is planning to use Windchill you should now familiarize yourself with Project
Link or Product Point before continuing with the rest of these exercises.




Once your team has been invited to the Windchill project you can access a wide range of
materials to help them make best use of PLM to manage their work including:

Introductory video: http://www.ptc.com/appserver/wcms/replay/index.jsp?&im _dbkey=97874
&im_language=en

Quick start:  http://www.ptc.com/WCMS/files/99574/en/Quick_Getting_Started_Guide.
pdf
Support videos: www.ptc.com/go/firstworkshops

Full guide: http://www.ptc.com/WCMS/files/77175/en/Getting_started guide.pdf

{4’5 Note: only teams formally registered with FIRST have automatic access to Windchill
Project Link or Product Point. Schools working on other robotics challenges can find
out how they can access PLM from PTC by contacting schools@ptc.com

This briefing is now complete.
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Briefing two — Pro|ENGINEER modeling

In this section we will show you how to open a robot modeled in Pro|[ENGINEER and
interrogate how it was assembled. This will help later when you are using mechanisms to
simulate robot movement.

The model used here is constructed from the parts available in the standard Tetrix™ kit
available from PitsCo™ (Part #: W39108) http://www.pitsco.com/

Pro|ENGINEER CAD files.

The kit of parts for the FIRST Tech Challenge has been modeled using Pro|[ENGINEER.
You or your teacher can download these from:

http://www.catalogds.com/db/service?d=first&c=browse or www.ptc.com/qgo/firstkop

The models needed for the exercises in this document are different from the parts kit
mentioned above and are provided in ANSI or ISO units in each team’s Windchill project.
This is the preferred way to access the FTC_Robot folders and files.

@ Note: Teams and individuals who do not have access to Windchill PLM can
download the FTC_Robot folder zip from:
https://pds.ptc.com/Windchill/netmarkets/jsp/project/view.jsp?oid=project%7Ewt.proj
mgmt.admin.Project2%3A183631245&u8=1

Extract the zip file structure to your work area on your local hard disk or local area
network.

Task one - Working with Pro|[ENGINEER.

Pro|ENGINEER is very powerful and as you work a wide range of file types will be
created. Unless these are properly managed you may not be able to find your work or
your models may not regenerate properly next time you open them.
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There are two things you can do to prevent these problems.

Set the working directory every time you start work on a model. Throughout this
project guide we assume you have set the working directory as the location of the
PTC robot; e.g. FTC_Robot or one the sub-folders.

Save any changes you make to models regularly, especially when prompted and
whenever there is a save option in a dialog. These include; parts, assemblies,
analysis playbacks, colors and appearances, materials, etc.

Tutorial files

There are two sets of sample files depending whether you wish to use ISO or ANSI

standards.
<FrC 150 JETC_ANSI
L) FTC_Robot L) FTC_Robot
L Distance [ Distance
L Friction L Friction
L) Gearing J Gearing
L) Geometry ) Geometry
T i I
'El Street_hockey_puck.prt 'El street_hockey puck.prt
[Ty [T
1. Choose which standard you will use and access the files from your team’s Windchill

project. Teams without access to Windchill should have extracted the files to their
working directory.

From this point on this document assumes you know which standard you are using and
whether you are accessing the sample files from Windchill or a local working directory.

Task two - Material properties

The exact size, mass and shape of all objects (parts) will need to be taken into account
when designing your robot. For example, we will show you how to interrogate the street
hockey puck from the FTC 2008 season.




Street hockey puck Air ball

Pro|ENGINEER can accurately represent the behavior of models providing the correct
properties are applied to parts. Street hockey pucks are injection molded from the thermo-
plastic PVC and a Pro|[ENGINEER model of the puck has been created.

The FIRST Tech Challenge 2008 focused on street hockey pucks. What properties are we
most interested in? It helps to list the actions you want to carry out on the object then list
the properties that will affect that action.

Action Material property

Slide Coefficient of friction, surface texture
Grip Coefficient of friction, surface texture
Lift Mass (density), inertia

In the parts folder you have a Pro|ENGINEER model of the ‘air ball’ used in the 2009-10
season. Once you have completed the next section you should use the techniques to
check the mass of the ball.

Material properties

You will now be shown how to interrogate the Pro|[ENGINEER model of street hockey
puck to find out about its properties.

1. Start Pro[ENGINEER

i=lfea) =7,

2. The navigator window on the left of the screen will be displaying
folders.

3. Navigate to until you can see the FTC_Robot listed in the browser window.

In the Browser window, right mouse click on the FTC_Robot folder and select Set
working directory.

5. In the Navigator panel, click on (4 Warking Directory 4 you should see the contents of
the FTC_Robot folder listed in the browser panel confirming the correct folder has
been set.
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6. Openthe part street_hockey_puck.prt

7. Inthe top toolbar use these buttons
- L]

datum information.

2/iexs to turn off the visibility of

8. Use the middle mouse button to click on the
model and drag to rotate it in the graphics

window.

9. Move the mouse cursor over the middle of
the model and roll the mouse wheel to zoom

in and out.

FIRST Tech Challenge

Don’t worry if the model disappears from view! The following two actions will sort things

out and return you to viewing the model.

EI;B

10. In the top toolbar click on

select Trimetric.

11. In the top toolbar click on ] the Refit button.

- the Saved views tool and from the drop-down menu

When viewing objects in 3D, we call these ‘get you out of Jail buttons’!

It is easy to see the physical shape of the object, created using the modeling tools in
Pro|ENGINEER. Not so obvious is the information about material properties and surface

texture.

12. In the Main tool bar across the
top of the screen click on Edit >
Setup and from the Menu
Manager on the right of the

screen select Material.

In the column on the right of the
Materials dialog you will see that PVC
is selected for this part. What
properties does Pro|[ENGINEER
understand for PVC?

13. In the Materials dialog, move the
mouse over the PVC material in
the right column, right click and
from the floating menu select

Properties.
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The Material definition dialog will open.

= = I
B Material Definition El rﬂ @
Name ”P':}"E’!
il 1] 1
n ezcnphon
Dieseription
Densty| 1. 29e-06 kg/mm™3 % Diereily 0 D4EE042 Ioimdini ™3 -
Appearance User Defned Stuctural | Thermal | Miscelaneous | Appesrance | User Defined
Shuctural Thermal Museelaneous Matesial Type| |sotrope: v
Propesties
Matenal Type |zobiopc o Sub Type| Linear w
gresres SubT Li Prezon's Ratio| 0.4
= e &t L
ke B Young's Moduhss | 2959912009 || Pa v
O B .1 Coeff. of Them Expansion| 305 " v
“foung's Modul: [193312+09] Pa b
n Failure Criterion
Coedf. of Thermal Expansion| 9e-05 . Nore =
Falwe Crkenion Fatigus
Nare w
Mone w
Fatigue:
Mene L
Ok [ Concel | Ok J[ Cancal |

14. Click on each tab and you will see the many properties Pro|[ENGINEER stores for

each material.

At the moment this will mean very little to you but would become very important if you

decide to become an engineer.

The physical properties we are most interested in here is the density, shown in the dialog

above the tabs.

Metric

ANSI

Density = 1.29e-06 kg/mm?.

This is telling us that a cubic millimeter of
PVC has a mass of 0.000 00129 kilograms

Density = 0.0467 Ib/in®

This is telling us that a cubic inch of PVC
has a mass of 0.0467 pounds

One of the best sites on the web for information on materials is www.matweb.com A
search for PVC on the site lists a confusing number of entries but if we select ‘Overview
for PVC, Molded’, MatWeb lists the average density as:

Metric

ANSI

Density = 1.29 g/cc

This is telling us that a cubic centimeter of
PVC has a mass of 1.29 grams

Density = 0.046 Ib/in®

This is telling us that a cubic inch of PVC
has a mass of 0.046 pounds

15. Click to close the Material Definition dialog, then to close the
Materials dialog, then Done to close the Menu Manager.



http://www.matweb.com/
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Material properties applied to FTC

FIRST Tech Challenge

Because Pro|ENGINEER stores information about PVC and this material has been

assigned to the street hockey puck, we can ask Pro|ENGINEER to analyze the model and

measure the mass of the puck.

16. The Street_hockey_puck.prt should still

be open on screen.

17. In the top toolbar click on Analysis then

Model and Mass Properties

18. In the Mass Properties dialog click on
to perform an analysis of the model.

Metric

B jdass Properties

%)

Anahisis | Feature

L [ Gelact temsz
[#] Uze Diatauk

Derety

Accwacy  |0.00001000 v

WOLUME = 1.103565%+05 MM™3 -
SURFACE AREA = 1.5544167e+04 WM™
DEMSITY = 1.2900000e-08 KILOGRAM .
MASS = 1423600 3e-00 KILOGRAM

CEMTER OF GRAVITY wath respect to _S
X £ 3213107 2e-03 0,0000000e-+

INERTIA with respect bo _STREET_HOCH
L
£ » ﬂ

Dk v

o) (%] [v] [X]

The results of the analysis are:
Volume = 110,000 mm?®
Surface area = 15,500 mm?
Density = 0.000 0129 kilograms / mm?®
Mass = 0.142 kilograms

ANSI

B Mass Properties

X

Anaksiz | Fagture

Csrs Select pams
[#] Uze Diatault

Darnsity

Agciracy 0.00001 000 »

WOLUME = £.7343784e+00 INCH"3 -
SURFACE ARES = 24093507e+01 INCH"2
DEMSITY = 4 580420702 POUND # INCH™3
Mass = 1738508601 FOLIND

CENTER OF GREVITY with respect lo _STREE
B2 126735204 0.0000000+00 00

INERAT L4 with iespect la _STREET_HOCKEY P
w
¢ >

[k

2] (%] [v] [X]

The results of the analysis are:
Volume = 6.73 in®
Surface area = 24 in?
Density = 0.0466 pounds /in®
Mass = 0.31 pounds

PTC — www.ptc.com
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Challenge

Use the same technigue to measure the mass of other components including the complete
robot model - PTC_robot.ASM

You will need the mass of the robot later to work out the coefficient of friction when
simulating things like wheel-spin.

Task three - Assembly

Assembly using Pro|[ENGINEER is very straightforward. Components are added to the
model and ‘constraints’ used to link components. Pro|ENGINEER uses two main types;
assembly constraints are most often used to fix two components together and
mechanism constraints allow known movement between components.

If you would like to learn about assembly constraints and mechanical connections take the
following Online Courses in PTC University Coach: http:/first.ptculms.com

e Assemblies > Bottom Up Design

e Introduction to Mechanisms > Start with Overview and Creating Mechanisms.

In addition, PTC’s schools curriculum contains projects covering aspects of mechanisms
including:

e Cam Toy/ Wind Sculpture (assembly, mechanism joints and cam connections)

Assembly applied to FTC

You or your teacher should already have downloaded the PTC robotics sample files and
made them available in your work area in a folder called FTC_Robot.

1.Start Pro|ENGINEER.

2.Browse to find the FTC_Robot folder and set it as the Working Directory.

3.0pen the assembly PTC_Robot.asm.

4.If necessary make datum information invisible — In the Main toolbar across the top of
the Pro|ENGINEER screen toggle these buttons = 2% 7 *% %% "%

You will see a robot similar to the one shown here.




5.In the model tree, locate the first sub assembly entry DRIVE_TRAIN_SUB.ASM and
click on the + to the left to see the components used in the sub assembly.

6.Right click on the entry CHANNEL-160MM.PRT and choose Edit Definition.

The model will change with many components grayed out and labels listing the assembly
constraints used to add the channel component to the model.

7.In the Dashboard open the Placement tab.
The placement tab list the three constraints, mate and two inserts.

= Saln4 [Uszer Dalined | ¥ Constraint Enabled
0 CHANNEL T60MM Surt| ||~ Conetant Trpe
09 CHANNEL 288MM:Sut] | | & M¥® « [Fel
Insesi Difzet
Inzat _[ Caincider -

Mew Cansliart

Stalus
Fuly Congtrained

Maw Set




8.Click on each entry in turn and you will see the constraint highlighted on the model.

In the illustrations above, the Mate has been selected in the Placement panel and the
surfaces are highlighted in red on the model.

9.In the dashboard, click on to close the placement dashboard.
In the File pull-down text menu select Erase then Current to close the current model

10.

and remove it from the computer’s volatile memory.

Assembling robot parts

This section will show you how to add components to a static model with assembly
constraints.

11.
12.

13.
14.

&

15.
16.

17.

18.

@‘/ El T_\; I User Defined j

Pro|ENGINEER should still be running with the
FTC_Robot folder set as the Working Directory

In the File menu select New and the new file
dialog will open.

In the dialog change the file Type to Assembly.
Type in a name for your assembly then click

Lok ],

Note: you cannot use spaces or reserved
characters in Pro|[ENGINEER filenames.

An empty assembly is created.
In the assembly toolbar on the right of the screen,

=
select % to add a new component to the
assembly.

In the list of files select channel-160mm.prt then

click _ Open |

The component will appear in the modeling
window of Pro|ENGINEER colored gray and the
assembly dashboard will open across the top of
the screen.

Flacement Move  Flexibiity  Properties

X
Twpe [ Sublype
S Skelch f+ Salid
& ) Pat " Sheetmetal
T Assembly

- LU Marufacturing
" [m] Drawing

" [ . Format

Mame I TE_szsembly

Comman Mame I

¥ |lze default template

Concel

[ Dt ~] [woT DEFINE =] A4 STATUS : Fully Canstrained =y 1] X

The first component in an assembly is normally fixed in position as a reference for other
components to be added.
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19. In the assembly dashboard, open the constraint
type list shown outlined in red above, and select
Default.

The component will be located in the assembly by lining
up all three axes of the assembly and part coordinate
systems.

@ Note: The channel component has turned a
mustard color to show it is fully constrained in the
assembly. This is confirmed in the dashboard.

Adding another component

As you have just seen, assembly involves selecting pairs of surfaces and creating
constraints between them. In the following example the two pieces of channel will have
three constraints; a mate and two inserts.

20. Inthe assembly toolbar on the right of the screen,

s
select ' to add a new component to the
assembly.

21. Inthe list of files this time select channel-
288mm.prt then click _ Open_|

The component will appear in the modeling window of
Pro|ENGINEER colored gray and the assembly
dashboard will open across the top of the screen.

O Ly N
AR LA S b s e it

COMPOMNENT PLACEMENT CONTROLS

Allows rearientalion of companents during placement

When adding components to an COMPONENT N . [IJ ,
assembly it is good practice to orient the brac ¢ W

new part close to where it will be located.
This is done using component placement _
controls explained in the Quick reference LU ¢ 1 EJ d
card.

MOVE Y I - IR 48»

22. Use the component placement controls to rotate
and move the new component until it looks like
this.

PTC — www.ptc.com page 17 of 116



Pro|ENGINEER Wildfire 4

23. Leftclick 8 on the top flat surface of the long
channel X1.

24. Left click @ on the underneath flat surface of
the short channel X2.

The long channel will move to mate the two surfaces

FIRST Tech Challenge

@ Note: You can select geometry ‘through’ the model using the Right-click EjfiIter.

Right click repeatedly in the area you are interested in until the geometry you wish to
select pre-highlights in light blue. Without moving the mouse left click to select the

geometry.

This takes a bit of practice but is much quicker than constantly rotating the model

until you can see the geometry you want to select.

25. Left click @ to select the cylindrical surfaces in
one of the large holes at the end of a channel
part.

26. Leftclick @ to select the cylindrical surfaces in
the hole in the end of the other channel

As two cylindrical surfaces were selected,
Pro|ENGINEER will correctly guess and apply an insert
constraint.

27. Repeat the process to add an insert constraint
between a pair of small holes in the ends of the
two channels.

Notice the long channel has turned mustard color to
denote it is fully constrained in the assembly.

28. In the Assembly dashboard, click ¥ on to finish
placing the long channel.

The assembly dashboard will close and the new
component entry is added to the model tree.

29. Save your model

PTC — www.ptc.com
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Pro|ENGINEER Wildfire 4 FIRST Tech Challenge

Adding a bearing
A bearing should be fixed in the assembly ready accept an axel later.
30. In the assembly toolbar on the right of the screen,

-
select % to add a new component to the
assembly.

31. Inthe list of files this time select
axle_bronze_bushing.prt then click _ Open |,

The component will appear in the modeling window of
Pro|ENGINEER colored gray and the assembly
dashboard will open across the top of the screen.

32. Use the component placement tools to re-orient
the bush and position it next to the fourth large
hole from the end of the long channel.

33. Select the cylindrical surface of the bush

34. Select the internal cylindrical surface of the large
hole and an insert constraint will be created.

35. Select the side of the channel for one half of the
mate.

36. Zoom in to select the underside of the flange on
the bush for the other half of the mate.

37. Inthe Assembly dashboard, click ¥ on to finish
placing the long channel.

The assembly dashboard will close and the bush
component is added to the model tree.

38. Add five additional bushes in the
locations shown here.

39. Save your model

Adding a moving component

Although mate, align and insert assembly constraints will allow movement,
Pro|ENGINEER has mechanism constraints specifically designed for common
mechanisms including pin, slider and cam.

PTC — www.ptc.com page 19 of 116



Pro|ENGINEER Wildfire 4 FIRST Tech Challenge

Using mechanism constraints will support
advanced techniques like motion analysis,
simulation and mechanism dynamics.

In this section you will add one of two sub
assemblies using mechanism connections.

The first contains an idler gear on an axel; the
other has a wheel, gear and axel.

40. In the assembly toolbar on the right

s
of the screen, select % to add a
new component to the assembly.

41. In the list of files this time select
large _gear_sub.prt then click
Open |

42. Use the component placement tools
to re-orient the sub-assembly as
shown here.

43. In the assembly dashboard open the mechanism list and select Pin.

’_IT“‘“/,’ |- Mare =l [T = [T 0ErmE =] % STATUS : Connection Defirion Comglets. | [ le
Placerend  Movwe Foahl Propeites

44. In the assembly dashboard open the
Placement drop-down panel and leave
it open for the next few steps.

45. Left click Ej to select the inside of
the middle bush.

46. Leftclick Ej to select the outside of
the axel.

47. The axel will be centered in the bush.
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The sub assembly will be free to move
through the bush. The next step adds

‘ H ’ H H -

translation’ constraints to stop axial - ™ P

movement. o "
Translation -.

48. Select the two surfaces shown here for
the translation references.

The gear axel sub assembly will move into
position and still allow rotation

| = Connecticn_3 [Pinl R Comstsint Eriptied
Loz shgriment .
49. The placement panel should now be [ Tacion Al
displaying the surfaces used to create [ ae seT_eowensa | | [0 2] il
the pin connection. | %0 AXLE BRONZE_BUSHIT | |
. Fiotalion fes | Canciders - |‘I_I' .'I-.-_']
50. In the dashboard click on ¥ to l E
complete the mechanism connection.
51. Save your model. HurrSat Stalus
i Carnecticn Definifion Complete.

52. Use the same technique to add two
instances of the sub assembly
Wheel_large-sub.asm creating a pin
connection.

53. Save your model.

Later you will be taught how to create gear
connections.

Task four - Mechanisms

A powerful set of tools are available in Pro|[ENGINEER to build, operate and test
mechanisms.

You can learn how to create mechanical connections by taking the following Online
Courses in PTC University Coach: http://schools.ptculms.com/

e Introduction to Mechanisms

In addition, PTC’s schools curriculum contains projects covering aspects of mechanisms
including:

e Cam toy/Wind sculpture (assembly, mechanism connections, cam connection)
e Mars rover (assembly, mechanism connections, cam connection)
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Mechanical connections applied to FTC

Pro|ENGINEER has a wide range of mechanical connections for modeling realistic
mechanisms.

1. The PTC_Robot.asm should still be open on screen.

Testing mechanisms

You can try out the kinematics (movement) of mechanical connections (and mechanisms)
simply by dragging them on screen.

2.In the top toolbar select Y the Drag components tool.
3.Move the mouse cursor over the perimeter of one of the drive wheels and

Left click ﬁ )

You will see a small diamond shaped target @ on the edge of the wheel.
4.Move the mouse to rotate the wheel and notice how the wheel rotates.

You will also be able to see gears along one side rotate according to the gear connections.
You will learn how this is done later.

5.When you have finished dragging the wheel, go to the Drag dialog and click Close.

Interrogate mechanical connections
6.In the model tree for the PTC_ROBOT.ASM, locate the first entry named

DRIVE_TRAIN_SUB.ASM, Right-click Ej and, from the floating menu, select
Open

7.In the model tree for the sub assembly locate the sub assembly WHEEL_LARGE-
SUB.ASM

T} DRIVE_TRAIN_SLB.ASM
L7 A5M_RIGHT

L AS_TOR
L7 ASM_FRONT
e A3 _DEF_CSYS
# -1 CHANNEL-268MM PRT
J AXIE-BRONZE_BUSHING PRT
1 AXLE-BRONZE _BUSMING PRY
1 AXLE-BRONZE_BUSHING PRT

L ]

&

-

L

1 AKLE-BRONZE _BUSHONG PR

# -1 AXLE-ERONZE_BUSHING PRT

CB] 4-EEL 1 ARGE-5UB. ASM]

o (LI WL (AAGE-SUB.ASM

#- L) OLARGE_GEAR_3E.ATM

. | CHANNEL- 1 60MM FRT

] BRACKET FLATFRT

31 DC_MOTOR_SUB_ASSY.ASM
& Insert Here

% Note: There is a small rectangle in front of the entry. This shows the sub assembly is
‘packaged’ and can move in at least one axis. This is why you could rotate the wheel
by dragging in the model.
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8.Right click over the entry in the model tree and from the floating menu select Edit
Definition.

9.In the assembly dashboard open the Placement panel.

L) DRIVE_TRADN_SLB, ASM
7 ASM_RTGHT il";-
£ RSW_TOR
A7 a5M_FROMT
2= B5M_DEF_C5YS
+ [ CHANNEL-208HM, PR
# || AXLE-BROMZE_BUSHING PRT
+ [ Al E-BROMEE _BUSHING, PRT ey
F [ A¥LE-BRONTE_BLEHING. FRT = . Axis alignment
& e
+
+

Trarslation

1l AMLE-BRUONZE _BUSHING PRT
| A¥LE-BRONZE_BUEHING.PRT
| ALE-BRONZE_BUSHING PRT

o Insert Hers

Entries below this in the model tree will be suppressed and you will see the Pin connection
for this sub assembly highlighted on the model and listed in the Placement tab of the
dashboard.

= Cornection_10 [P
049 A4LE-D-SHAFT-SufFe] | Conetiant Type
9 AXLE-BRONZE_BUSHIl | | &2
T ranslston Diifzet
FAotation Az T

Stahus
Caonriction Definition Complate.

Mew Set

10.Left Click @ on each entry in the Placement tab and notice the geometry
highlighting on the model.

11.In the assembly dashboard left click on to close then close the sub assembly
to get back to the PTC_Robot.

12.Close the PTC_Robot.asm

13.0pen the File pull-down menu, Left click Ej Erase and from the floating menu click
on Erase not displayed...

14. Left click tj on OK to close the dialog.

You should now have a clear idea how the concepts you learned in Coach have been
applied to the PTC Robot.
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Creating gear connections

Pro|ENGINEER has sophisticated mechanism simulation tools. The next section will
show you how to create gear connections between the driving wheels of the robot.

@ Note: Gear connections can only be created on rotating axles created using pin

connections.

The robot model you will be working on has gear pairs with 120 teeth and 80 teeth.
Pro|ENGINEER lets you enter the gear information in a number of ways including pitch
circle diameters or as a ratio. This example will use a ratio of 3:2 derived mathematically

as follows.

120
80

3
2

15. Open the assembly model you created
earlier or TB_ASSEMBLY.ASM

The three axels have pin connections and
are able to rotate independently. You will
now add gear connections to link them
together.

16. In the main toolbar open the S vECHANISHY
[ -=3, BODIES

Applications pull-down text menu and AE sravry
25D

. = COMNECTIONS
select Mechanism - 3 MoToRs

. . . . - % SPRINGS
An extra mechanisms section will appear in ,f;mmpms
; [}~ FORCES/TORQUES
the model tree and the mechanism toolbars R TITEAL CEneTcs
open on the right of the screen. - 3 ANALYSES

L4 B PLAYBACKS

17. The model will also be showing the pin connections
on each of the axels.

18. In the mechanisms toolbar on the right of the screen click

&

=¥ o create a new Gear connection.

The gear pair definition dialog opens with the Gearl tab
selected.

19. On the model, click on the pin connection symbol on the
central gear axis.

S0 o |
4
& 2
2 o E:
P
[
1
(%
x
Hame 1
IGea’F‘aﬂ
Type
| Standard ﬂ
Gearl IEeal’EI F'muellia-sl
Iation Asiz
& | |Connection 8 a1
Body
Gear
|boys
— Canier A
[boa3
Ptk Cinzle
Diiamedes
IIZI mm
lzan Location
L

0K | apply | Concel |
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20.

21.
22.
23.
24.
25.

26.

27.

28.

29.

In the dialog select the Gear?2 tab then select the pin
connection axis on one of the wheel axels.

In the dialog select the Properties tab.
Change the Gear ratio option to User Defined
In the Gearl field enter the value 3

In the Gear2 field enter the value 2

Click OK to close the Gear Pair Definition dialog and
complete the gear connection

Test the mechanism by holding
Ctrl+Alt and dragging the central
gear.

The wheel should rotate at a speed
governed by the gear ratio.

Add another gear pair between the
central gear and the other wheel.

Test the mechanism works
correctly.

Save the sub-assembly.

xl
Name:
|TG=:|'P¢|H
Tvpe
| Standard =]

FIRST Tech Challenge

Gearl Gea? | Fropertes |
— Matio Az
il Conneciion_13.ans_1 5Z

B

I Gear Pair Definition x|

Hame
|TG=:|'P‘:|H
Type
ﬂSlandmd =l

Goarl | Gear2 Propesies |
— Gear Ralio

| Lisei Defined ;il

P Gearl Gesd

E— | —
— Camier Body

™ Disable Creston of an Intesnal Cammes Body

0k | épply | Caneel |
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A complete robot chassis can now be
created by starting a new assembly then
adding two instances of the sub-
assembly.

Task five - Part modeling

You can learn how to model components by taking the following Online Courses in PTC
University Coach: http://schools.ptculms.com/

e Modeling > Basic Modeling and Manipulating Sketches and Rounds and Basic
Modifications.

Fevalved Feature

In addition, PTC’s schools curriculum contains projects covering aspects of part modeling
including:

e Sports bottle (modeling parts)
e Starchaser Rocket (modeling parts)
e RP Car (modeling parts, teams modeling concurrently)

Solid part modeling applied to FTC
We will explore the wheel hub component to learn how Pro|ENGINEER models parts.
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Make sure the FTC_Robot folder is set as the Working Folder.
Open the part hub_4 inch.prt

Look at the model tree and you will see the ‘history’ of how the wheel hub was
created.

] HUE_4_INCH_PRT
A ATEAITUZOAITAIEIES] 1
LFoTML
7 oMz

[T oTME /
HUB_SECTION -

F7 OTH4

CENTER_HOLE
THER:_HOLES
CUTER_HOLES

+ oo Revalee |

B -5 Extrude 2

# [1:] Patterm | of Extruda 2 (2)

i [22) Patterm 2 of Extrude 2 ()

o Insart Hers / /
g

4. Drag the # InsertHere faq to below the Revolve 1 entry.
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1 HUB_4_INCH.FRT
3{% AZEAYS929A2 74960831 13FE
7 0TM1
F7 DTMz
£7 DTM3
HUE_SECTION
£7 DTM4
CENTER_HOLE
IMMER_HOLES
CQUTER_HCOLES
+ o;h:u Revolve 1
H Insert Here
7 Extrude 2
+ :I "Pattern 1 of Extrude 2 (2)
+ :I "Pattern Z of Extrude 2 (3)

The model will update to show the model at this stage with entries below the Insert flag
suppressed. The small black squares next to these entries show they are suppressed and
not being shown in the model.

5. Click on the + to expand the revolve feature then click on the internal sketch
HUB_SECTION.

) HUB_4_IMCH.PRT
3{* A25A950200274060B31 13FE
A7 DML
7 DTME
A7 DTM3
HUB_SECTION -
7 DTM4 e
CEMTER_HOLE o~
INMER_HOLES i
OUTER _HOLES =
=-ho Revalve 1

P Inserk Here

7 "Extrude 2 e
+ j "Pattern 1 of Extrude 2 (2) L
- [:] "Pattern 2 of Extruds 2 (3)

The section sketch and center line used to create the revolve will be highlighted on the
model.

6. Dragthe % Insert Here flag down one entry at a time and investigate how each part
of the model was created.

7. Repeat the previous section on the dc_motor_mount.prt to see alternative features in
use.

8. Close all models and Erase not displayed.

Task six - Sheet metal modeling

PTC University Coach contains tutorials on how to model components using the sheet
metal tools in Pro|ENGINEER. The Online Courses can be found at:
http://schools.ptculms.com/
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e Sheet metal design > Basic Concepts and Attached Walls.

°

In addition, PTC’s schools curriculum contains projects covering aspects of sheet metal
modeling including:

e Periscope (Sheet metal conversion from solid - Rip)
e Deodorant bottle (Sheet metal adding 'walls’, nets)

Sheet metal modeling applied to FTC

To understand how sheet metal tools were used to create components for the Tetrix™ kit
we will look briefly at the one of the servo brackets.

1. Make sure the folder FTC_Robot is set as the Working Directory
2. Openthe part bracket_servo_sm.prt

[") BRACKET_SERMO_SM.PRT
L7 FRONT
7 TOP
17 RIGHT
A DEFALILT_C5Y5
& FIRST WLl
L Flat 1
L Flat 2
o Extrude 1
&7 Extrude 2
P Inserk Here
®Flat Pattern id 642

Notice the F* Insert Here flag is not at the bottom of the model tree? This will be
explained shortly. First let’s look at the rest of the model tree.

3. Dragthe # InsertHere fiag to below the FIRST WALL feature. The remaining
features will be suppressed.
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[T] BRACKET_SERYWC_SM.PRT
{7 FRONT
F7TOP
7 RIGHT
A DEFALLT_C5YS

&.f FIRST walL

& Insert Here

&L "Flat 1

L Flat 2

o7 "Extrude 1

7 "Extrude 2

WFlat Pattern id 642 \/

This is the first flat shape on which all the other shapes will be attached.

4. Dragthe % Insert Here flag down one step at a time to see how the component was
created.

Ly

5. Inthe model tree Right-click Ej on the Flat 1 entry and from the floating menu
choose Edit Definition.

The Create Flat Wall dashboard will open showing how the feature was created and the
model will display the edge selected for the wall attachment. Open the Shape tab and you
will see the profile sketch used to define the outline of the wall.

6. Inthe assembly dashboard left click on to close

7. Finally, drag the ® Insert Here fiag to the bottom of the model tree.
The final entry in the model tree flattens the sheet metal component.
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|_J BRACKET_SERWO_SM.PRT
{7 FRONT
£ Top
£ RIEHT
¥x DEFALLT _CSYS
+ 5 FIRST WaLL
gL Flat 1
L Flat 2

& 7 Extrude 1

o |_" Extrude 2
[ Flat patrern d 642
& Insert Here

.-
N —
\

=
R

The fold/unfold process takes into account the material properties which Pro|ENGINEER
stores in a ‘bend table’ for each type of material.

8. Close all models and Erase not displayed.

Task seven - Manufacture

Note to reviewers - Teams can only use parts in the kit so this section is superfluous and
will be deleted unless a good argument is made otherwise?

1.  Full scale drawings > 2D print for manufacture templates

2D CNC output — model > drawing > dxf > laser/slot drill CNC

2
3. 3D CNC output — model > stl > post process > 3 axis machining
4. 3D CNC output — model > Expert machinist 2.5D

This briefing is now complete.
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Briefing three — Stability and structures

FIRST Tech Challenge

The centre of gravity of a model can be important for a number of reasons. A simple way

of thinking about stability is the width of a model compared with its height.

Tall models are more likely to fall over.

To understand the concept of stability, imagine a square based pyramid and how you

might stand it on a surface. Below are four positions
1.

2
3.
4

The vertex

An edge

A triangular face
The square face

PTC — www.ptc.com
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In which, if any, of the positions would the pyramid fall over?

1. Diagram one is the most unstable and would fall over in any direction.

2. Diagram two is the next most unstable and would fall over along an axis running
through the edge resting on the base.

3. Diagram three is the first to be stable. The pyramid would not fall over.

Diagram four is also stable. The pyramid would not fall over.

These solids will be animated with exciting new techniques in Pro|ENGINEER Wildfire 5.0.
For s sneek preview of what is possible look at:
http://www.youtube.com/watch?v=0GJHz7Jvad4

Stability in the context of FTC

In the context of FTC we will explore the stability of various simplified robot designs based
on Tetrix™ components. This should help you apply the principles of stability to your First
Tech Challenge designs.
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Task one - Four points of contact — Car

It is no accident that most cars have four
wheels. Points of contact at all four
corners with the center of gravity acting
downwards in the middle provide a very
stable vehicle.

A four wheel vehicle is inherently stable.
An easy way to think of this is what would
happen if you drop a car from a modest
height? There is a good chance the
vehicle will land and remain upright.

http://livedesignonline.com/stagingrental/Vertigo.jpg

Drop-Test

A Pro|ENGINEER simulation has created with a four wheeled robot chassis a short
distance above the flour. Four cam connections link the wheels to the floor. With gravity
applied, the robot drops to the floor coming to rest after some bouncing.

Start Pro|[ENGINEER.

Set the working directory to
\FTC_Robot\Stability\Fourcycle.

3. Open the assembly Stability-fourcycle.asm
Zoom until the model looks like this.

5. Atthe top of the Pro|[ENGINEER screen open
the Applications pull-down text menu and
select Mechanism.

@ Look for the four cam connection
symbols on the model plus the light blue lines
and mesh to show cam surfaces. A
mechanism tree will also appear below the
normal model tree.
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6. In the mechanism tree, expand the

ANALYSES sub heading then Right-click @
over Drop_test (DYNAMICS) and from the

floating menu select Run.

Pro|ENGINEER will mathematically apply gravity
and friction to the model, and move the parts
according to the forces acting on them.

FIRST Tech Challenge

You should see the model drop, bounce a little then

come to rest like this.

@ Note: The movement may not be smooth as the analysis is not carried out in real
time. Running the analysis calculates and stores the position of the all the
components for each time period ready for later viewing. Analyses of complex
models can take hours for movement that might replay in a few minutes at real time.

Playback

To see the results of the analysis we use playback controls.

7. Near the bottom of the
mechanism tree expand the
PLAYBACK entry.

8. Right-click Ej over the entry
for Drop_test and, from the
floating menu, select Play.

After a short pause the Animate
dialog will open.

9. Inthe Animate dialog select the

Repeat |E button then click
onplay L » .

You will see the analysis being played
back slowly on screen with readout of
time.

10. Experiment with the speed slider
and other control buttons.

11. With the animation running, try
rotating and zooming in on the
model.

G MECHANISM
-2l BODIES
..... & GRAYITY
g...ﬂ' CONMECTIONS
- ) MOTORS
----- 2 SPRINGS
----- 4¢" DAMPERS
----- [~ FORCES{TORGUES
-7 INITIAL CONDITIONS

= 5 ANALYSES
“o 3 Bumpy_road (DVMAMICS)
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Video capture

FIRST Tech Challenge

If you want to share your animations with others who don’t have Pro|ENGINEER installed

you can capture the current view as a video file.

12. Resize the ProE window to
reduce the size of the graphics
window. This cuts down the

size of the MPG file.
In the Animate dialog click on

the button to open the

Capture dialog.

Pro|ENGINEER will default the image
size to match the current graphics
window.

13.

14. Complete all the options then
click .

The MPG file will be created but may
take a few minutes.

15. Close the Playback dialog.

I= Capture

M arme

|STABILITY-UNICYCLE mpg| [ Browse... |

Tupe
| MPEG v

Image Size:
“Width | B40
Height | 853

Lock Aszpect Ratio

Fixels

Fixels

Cuality
[ Phatorender Frames

Frame Fate
| 25 fps v

The same assembly will be needed for the next section.

Bumpy floor

Although four wheeled vehicles are stable
on bumpy surfaces one or more wheels
can break contact with the floor unless
some form of suspension or compliant
chassis is designed.

http://farm4.static.flickr.com/3258/2892692698 0b4160c271.jpa?v=0
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For the next activity we have provided two
different Pro|[ENGINEER models to
illustrate the benefits of suspension.

The first has a rigid chassis with no
suspension while the second hinges the
chassis in the middle similar to dumper
trucks.

Fixed chassis

Pro|ENGINEER should be running with the same
assembly used in the previous activity open.

16. If not, set the working directory to
\FTC_Robot\Stability\Fourcycle and open
the file STABILITY _FOURCYCLE.ASM

17. Zoom until the model looks like this.

18. If the model is not sitting on the floor look in the Main toolbar across the top of the
screen and select the Drag components tool Ly

19. The drag dialog opens. Make sure the Snapshots tab is active then Double click on
the Bumpy_road entry.

20. Click on to close the Drag dialog.

21. At the top of the Pro|ENGINEER screen open
the Applications pull-down text menu and
select Mechanisms.

@ Look for the four cam connection
symbols on the model plus the light blue lines
and mesh to show cam surfaces. A
mechanism tree will also appear below the
normal model tree.

22. In the mechanism tree expand the ANALYSES sub heading then Right-click Ej
over Bumpy_road (DYNAMICS) and, from the floating menu, select Run.

Pro|ENGINEER will mathematically apply gravity and friction to the model, and move the
parts according to the motors driving the wheels and the forces acting on the model.
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% Note: This simulation may take a long time! Pro|ENGINEER is doing a great
deal of mathematical calculation.

You should see the model drive across the floor and over the bumps.

‘o # ¢
.\. :x 2 Mo :

t
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v
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|
Time 1.20618 N T _.J

Mecharsem v

a e

Notice the progress bar along the bottom of the screen showing elapsed time, a progress
bar and a red record button. If Pro|[ENGINEER seems to have frozen be patient, check
the elapsed time which should still be increasing. The analysis should finish after a while.

@ If the time indicator stops increasing, the red record button can be used to stop the
simulation before the end.

@ Note: Just like the previous analysis, movement on screen during recording may
not be smooth as the analysis is not carried out in real time. The analysis calculates and
stores the position of the all the components for each time period ready for later viewing.
Analyses of complex models can take hours for movement that replay in seconds at real
time.

23. Once the simulation has
finished, open the playback in
the mechanism tree

24. While it is playing, zoom and
rotate the model to examine
the way the wheels leave the
floor as the robot drives over
the bumps.

The next analysis will demonstrate a robot chassis with a simple form of suspension.
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Hinged chassis

25.
26.

This empties the memory of previous models.
27.

28.

29.

30.

31.

32.
33.

34.

Pro|ENGINEER will mathematically apply gravity

Close all models then open the File menu and
select Erase.

From the floating menu select Not displayed
then OK to close the dialog.

The working directory should still be
\FTC_Robot\Stability\Fourcycle.

Open the assembly
Suspension_fourcycle.asm

Zoom until the model looks like this.

If the model is not sitting on the floor, look in the Main toolbar across the top of the
screen and select the Drag components tool Ly

The drag dialog opens. Make sure the Snapshots tab is active then Double left

click @ on the Bumpy_start entry.

Click on to close the Drag dialog.

At the top of the Pro|[ENGINEER screen open
the Applications pull-down text menu and
select Mechanisms.

Look for the four cam connection

symbols on the model plus the light blue lines
and mesh to show cam surfaces. A
mechanism tree will also appear below the
normal model tree.

In the mechanism tree expand the ANALYSES
sub heading then Right-click 6 over

Bumpy_road (DYNAMICS) and from the
floating menu select Run.

and friction to the model, and move the parts
according to the forces acting on them.

You should see the model drive across the floor and over the bumps.

% Note: Just like the previous analyses, during recording the movement may not be

smooth as the analysis is not carried out in real time.
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35. Use the playback tools to replay the simulation
and zoom in to see how all four wheels remain
in contact with the floor while negotiating the
bumps.

36. Close all models and Erase not displayed.

Task two - Three points of contact — Trike

A tricycle is almost as stable as a four wheel vehicle and doesn’t need suspension to
negotiate uneven surfaces.

1. Close all models then open the File menu and
select Erase.

2. From the floating menu select Not displayed
then OK to close the dialog.

This empties the memory of previous models.

3. Change the working directory to
\FTC_Robot\Stability\Tricycle.

4. Open the assembly — Trike_drop.asm

5.  Zoom until the model looks like this.

6. If the model is not floating above the floor, look in the Main toolbar across the top of
the screen and select the Drag components tool by

7. The drag dialog opens. Make sure the Snapshots tab is active then Double Left-
click on the Trike_drop entry.

8. Click on [Zes= Jto close the Drag dialog.
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9. Atthe top of the Pro|ENGINEER screen open
the Applications pull-down text menu and
select Mechanisms.

@ Look for the three cam connection
symbols on the model plus the light blue lines
and mesh to show cam surfaces. A
mechanism tree will also appear below the
normal model tree.

10. In the mechanism tree expand the ANALYSES

sub heading then Right-click Ej over
Trike_drop (DYNAMICS) and from the floating
menu select Run.

Pro|ENGINEER will mathematically apply gravity
and friction to the model, and move the parts
according to the forces acting on them.

You should see the model fall down on the floor, bounce a little then come to rest.
{’5”5 Note: Just like the previous analyses, during recording the movement may not be
smooth as the analysis is not carried out in real time.

11. Use the playback tools to replay the simulation and zoom in to examine how the
tricycle settles on its wheels.

12. Close all models and Erase not displayed.

All of the stability models studied so far have been naturally stable.

The next three models are inherently unstable and would need some form of active control
if they were used as the basis for a robot.

Task three - Two points of contact — Bicycle

Bicycles will not remain upright without input from the rider. This can be demonstrated by
trying to stand a bicycle up in Pro|ENGINEER.

@ Note: because cam connections only work in a single plane, ‘dummy’ components
hidden by the floor have been used to allow the bicycle frame to move in a natural way.
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1. Change the working directory to
\FTC_Robot\Stability\Bicycle.

Open the assembly — Bicycle_drop.asm
Zoom until the model looks like this.

If the model is not sitting on the floor look in
the Main toolbar across the top of the screen

and select the Drag components tool

5. The drag dialog opens. Make sure the
Snapshots tab is active then Double Right-

click Ej on the Bike_drop entry.

6. Click on 2= Jto close the Drag dialog.
7. Atthe top of the Pro|ENGINEER screen open

the Applications pull-down text menu and
select Mechanisms.

% Look for the two cam connection
symbols on the model plus the light blue lines
and mesh to show cam surfaces. A
mechanism tree will also appear below the
normal model tree.

8. Inthe mechanism tree expand the ANALYSES SLHECHANISH
G I::I---d% BODIES
. - «- 3« Yy e GRAVIT\T‘
sub heading then Right-click -~ over D__#CONNECTIONS
Bicycle_drop (DYNAMICS) and from the - P MOTORS
floating menu select Run. :é;m‘f;g
Pro|ENGINEER will mathematically apply gravity D%?@if:fggﬁ%‘fém
and friction to the model, and move the parts 5 S ANALYSES
according to the forces acting on them. - 4;".;%‘; f;:lcvésbeﬁnitionl (DYNAMICS)

You should see the model fall down on the floor, bounce and then fall over.

% Note: Just like the previous analyses, during recording the movement may not be
smooth as the analysis is not carried out in real time.
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9. Use the playback tools to replay the simulation
and zoom in to examine how the bicycle falls
over.

This is the first model we have seen which is
unstable. You may be interested in searching the
web for research designing bicycle robots with
dynamic stability control systems.

10. Close all models and Erase not displayed.

Task four - Two points of contact - Segway™

The founder of FIRST, Dean Kamen has many
inventions to his name including medical devices
that have helped lots of people. However, the
invention Dean Kamen is most famous for is the
Segway™ personal transporter where the rider
stands between two wheels either side of the
machine.

Instinct makes us think the Segway™ will fall
forwards or backwards but in practice this doesn’t
happen.

What do you think stops it from falling over?

Sensors in the Segway™ detect when it is tilting
from the horizontal and power the wheels in the
direction of the tilt until the machine is back to
vertical. This is called ‘Active stability control’.

Does this remind you of the way a unicyclist avoids
falling forwards or backwards?




How Segway™ works
Upright Falling forwards Falling backwards

Cof ¢ C
No drive Motors drive Motors reverse
needed forward to move to move wheels
wheels unde_r under centre of
centre of gravity gravity

This is the same process a bike rider uses to
wheelie.

Accelerate to increase the height of the front
wheel and move the rear wheel under the C of G

Decelerate/brake to lower the height of the front
wheel and move the rear wheel under the C of G.

Segway™ stability

Like a bicycle, the Segway™ will only remain upright with control input. This comes from
sensors controlling the motors. We will demonstrate the inherent instability in the following
Pro|ENGINEER assembly.

@ Note: because cam connections only work in a single plane, ‘dummy’ components
hidden by the floor have been used to allow the Segway™ to move in a natural way.

1. Close all models then open the File menu and
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This empties the memory of previous models.
3.

select Erase.

From the floating menu select Not displayed
then OK to close the dialog.

Change the working directory to
\FTC_Robot\Stability\Segway.

Open the assembly Segway_stability.asm
Zoom until the model looks like this.

If the model is not sitting on the floor look in the Main toolbar across the top of the
screen and select the Drag components tool Ly
The drag dialog opens. Make sure the Snapshots tab is active then Double Left-

click Ej on the Segway_topple entry.
Click on to close the Drag dialog.

At the top of the Pro|[ENGINEER screen open
the Applications pull-down text menu and
select Mechanisms.

Look for the dummy_floor components and

three cam connection symbols on the
model plus the light blue lines and mesh to
show cam surfaces. A mechanism tree will
also appear below the normal model tree.

10. In the mechanism tree expand the ANALYSES sub heading then Right-click Ej

over Segway_topple (DYNAMICS) and from the floating menu select Run.

Pro|ENGINEER will mathematically apply gravity and friction to the model, and move the
parts according to the forces acting on them.

You should see the model fall, bounce, then fall
over coming to rest lying on the floor.

% Note: Just like the previous analyses, during

recording the movement may not be smooth
as the analysis is not carried out in real time.
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11. Use the playback tools to replay the simulation
and zoom in to examine how the Segway™
settles on its wheels.

This is the second unstable model studied so far.

Task five - Single point of contact — Unicycle

FIRST Tech Challenge

A Pro|ENGINEER simulation has been set with a unicycle standing on a flat surface.
Three cam connections simulate contact points between the unicycle and the floor.

With gravity applied, the unicycle topples over coming to rest lying on the floor.

Start Pro|[ENGINEER.

2.  Set the working directory to
\FTC_Robot\Stability\Unicycle.

3. Open the assembly Stability-unicycle.asm
Zoom until the model looks like this.

5. At the top of the Pro|ENGINEER screen open
the Applications pull-down text menu and
select Mechanisms.

\’% Look for the three cam connection C' S

symbols on the model plus the light blue mesh
to show cam surfaces. A mechanism panel
will also appear at the bottom of the model
tree.

6. In the mechanism model tree expand the

ANALYSES sub heading then Right-click 6
over Unicycle_stability (DYNAMICS) and
from the floating menu select Run.

Pro|ENGINEER will mathematically apply gravity
and friction to the model, and move the parts
according to the forces acting on them.

You should see the model topple over and come to
rest, probably upside down like this.

PTC — www.ptc.com

page 46 of 116



@ Note: The movement may not be smooth as the analysis is not carried out in real
time. The analysis stores the position of the all the components for each time period
set in the analysis definition ready for later viewing.

Playback

To see the results of the analysis we use playback controls.

7. Near the bottom of the
mechanism tree expand the
PLAYBACK entry.

8. Right-click Ej over the entry
for Unicycle_stability and, from
the floating menu, select Play.

After a short pause the Animate
dialog will open.

9. Inthe Animate dialog select the

Repeat button = then click
onplay L » .

You will see the analysis being played
back slowly on screen with a readout
of Time.

10. Experiment with the speed
control slider and other buttons.

11. With the animation running, try
rotating and zooming in on the
model.

Video capture

ST MECHANISM

=l BODIES
|E cravITy
| CONMECTIONS
) MOTORS
2 SPRINGS
4¢ DAMPERS
[#~ FORCES{TORQUES
77 INITIAL CONDITIONS
= 2 ANALYSES
:}E_Unicycle_stability (DYMAMICS)
=4 b PLAYBACKS
1 3 Inicycle_stability

Frame

-

0 = 20

4 | m | »

EEEReER:
Spend

=] =) ]
(i)

If you want to share your animations with others who don’t have Pro|ENGINEER installed

you can capture the current view as a video file.




12. Resize the ProE window to reduce the size of the

graphics window. This cuts down the size of the Name
MPG file. STABILITY-UNICYCLE mpg
Type
13. In the Animate dialog click on the (Capure.. Joytton to MPER -
open the Capture dialog. o S _
idth | B40 Pixels

Height | 854 Pixels

14. ProE will default the image size to match the current
Lock Aspect R atio

graphics window.

Duality

15. Complete all the options then click ok ], L] Photorender Fames
Frame R ate
16. The MPG file will be created which may take a few 2 fps v
minutes.

17. Close all models and erase all files from memory.

Unicycle theory

Understanding how a unicyclist balances on
a single point of contact with the ground will
help you understand the control systems for

robotics.

The rider has two main actions to ‘control’
the movement of the unicycle;

1 Pedaling forwards and backwards

2.  Steering by swinging their hips. @ ;
Falling forwards - Imagine the unicycle is

beginning to fall forwards; the rider senses g

this and pedals forwards to bring the
In practice the rider is constantly sensing the vertical axis of the unicycle and

unicycle upright, i.e. with the centre of
gravity directly over the wheel contact with

steering/pedaling in the appropriate direction to keep the wheel contact below the centre of
gravity.

the ground.

Falling sideways — This requires two inputs
by the rider. The unicycle is falling
sideways which the rider senses and
swivels their hips turning the wheel to face
in the falling direction. The rider can now
pedal forwards to bring the unicycle back to
the upright position.

This briefing is now complete.




Briefing four — Electric motors

These are probably the most common ‘actuators’ in use today. Electric motors can be
found in electric screwdrivers, digital cameras, cars, elevators, etc.

Motors applied to FTC

The example robot provided in this project guide uses most of the components in the
Tetrix robot kit. The wheels and shoulder joint are driven using the geared DC motor and
the elbow and gripper movements are driven by servo motors.

Things can become confusing when the following Pro|ENGINEER simulations use a
‘servo motor’ to drive the robot wheels and a force motor to operate the gripper.

DC motor and servo motor

Electric motors and servos are key output devices for robotic control systems. Two
different types of electric motors are provided in the FTC Tetrix™ kit. Each provides a
different type of rotational movement.

The DC geared motor will continue to rotate as long as it is switched on.

The Servo motor rotates through only 180 degrees and maintains a position depending
on the square wave signal being sent to it. This will be explained in more detail later.




DC geared motor

The DC motors have a built in gearbox that reduces the rotational speed and increases the
turning force (torque) of the output shaft.

The input to the DC geared motor is a voltage up to 12v dc across the two terminals.
While connected, the spindle revolves continuously. Reversing the voltage reverses the
direction of the output shatft.

Clockwise counter clockwise
+12v
Ov 1sec 2dec 3sec 4sec
-12v

The graph above shows +12v being applied to the motor for two seconds and -12v for the
next two seconds. We would expect the motor to turn clockwise then anticlockwise with
the spindle ending up exactly back where it started

The DC geared motor in the Tetrix™ kit does not have feedback which can cause
problems if the motor stalls. IN the context of an FTC robot this may not be a problem as
the torque available from the DC geared motors is quite considerable.

A data sheet is available for this motor which includes the following information:
e Rotational speed: 154 revolutions per minute (rpm)
Stall torque: 23.40 Kg cm (1ISO) 325 oz/in (ANSI)

This information was used to construct Pro|ENGINEER models including a ‘servo’ motor
turning the output shaft from the gearbox. Later in this tutorial you be shown how these
can be built into virtual robots.




Pro|ENGINEER Wildfire 4 FIRST Tech Challenge
CAD model

1. Set the working directory to \FTC_Robot

2. Openthe model dc_turning_demo.asm

3. Openthe Applications pull-down menu and select Mechanisms.

The model is a DC geared motor with a small gear fixed to the spindle. You should see
two symbols;

Denotes a ‘Pin’ mechanical connection exists, in this example allowing the spindle
of the DC geared motor to rotate.

Cg— Denotes a ‘servo’ motor, in this case driving the output shaft of the DC geared
motor.

4. At the bottom of the model tree, in the mechanisms section, expand MOTORS and
SERVO then right click on the ServoMotor 1 entry.

5.  From the floating menu select Edit Definition

IE Secrva Moter Definition
Nane
Setvooton
% MECHANISH Type  Paciie
- = BOOIES Specicalon
E GRavITy 2 T veocr = P
= [ conmecttons 3] | dep
= [+ J0InTs Indiad Snghe
% 54 Connaction_) (00_GEARMEAD_MOTCR) [ Cunert
2, ZAMS ‘
-""J SEARS S 0 |dsg
= MoToRs
= s Magritude
* torl (VEL - DC_TURNING DEMO)! Coratant v
B FORCE
F FRINGS AW
Y DWFERS .
¥ FCRCES(TORGLES < e
SR TNITIAL CONDETIONS kx 8\/
# X anavsss ] Velooty
4P PLAYRATKS ] In sapatste graphe 7] Acceleration
oK ] [ 2ep | | Cancel |
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In the Servo Motor Definition dialog the Type tab is listing the motion axis for the pin, in
this case the rotation axis of the servo motor.

6. Select the Profile tab.

This shows the ‘servo’ motor drives the shaft at a constant rotational ‘velocity’ of 924
degrees per second. Where do you think this value came from?

7. Left Click @ to close the Servo Motor Definition dialog.

8. Inthe mechanism tree expand the ANALYSES heading, Right-click @ over
Motor_turn (POSITION) and from the floating menu select Run.

9.  Once the analysis has finished, use the PLAYBACK to look at the motion in detail.
10. Close the model and erase models from memory.

Calculating rotational velocity

The data sheet for this DC geared motor specifies a rotational speed of 154 revolutions
per minute (rpm). To convert this to degrees per second:

Convert minutes to seconds

154 = 2.57 revolutions per second
60

Convert revolutions to degrees
2.57 x 360 = 925 degrees per second




Pro|ENGINEER Wildfire 4

RC Servo motor

These are based on a small DC motor packaged with a
geared reduction and electronic control system. The
output shaft provides low speed of rotation and high
turning force (torque).

Built into RC servos are sensors to detect the rotational
position of the output shaft and electronics to link motor
control to the shaft positional information.

FIRST Tech Challenge

http://en.wikipedia.org/wiki/Servomechanism
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A constant stream of high frequency pulses control the position of a servo motor.

The difference between the on and off time sets the position. Here we show the pulse
signal and the position of the servo for three different electronic signals.

Minimum rotation Mid position Maximum rotation
On S
Off
e = = = N e = = = PN e = =~ = N
8 B 8 & 8 8 % 8 & 8 8 B 8 & 8
i 8 3 i 3 s 3 3 3 3 i 3 3 3

. = . =
ri @”

The RC servo motors in the Tetrix™ kit will only rotate through 180 degrees. This has
been built into the Pro|ENGINEER model.

11. Setthe working directory to \FTC_Robot
12. Open the model SERVO_HS475.ASM

13. Use ’%{r? Drag or Ctrl+Alt+Left Click @ to find out how the output horn moves in the
assembly.




The horn should only move through half a revolution.
14. In the model tree find the entry for * ERVD_METAL-HORN-F'RT.

Between the icon and text is a very small square with a dot in the centre, highlighted
above with a red circle. The square represents a component which is ‘packaged’ with at
least one degree of movement within the assembly. The dot tells us this component is
assembled using a mechanical connection rather than an assembly constraint. Let’s look
inside this mechanism connection.

15. In the model tree right click on SERVO_METAL-HORN.PRT and from the floating
menu choose Edit Definition.

The Assembly dashboard will open and the metal horn will change color to yellow to show
this is the component we are investigating and the assembly connection is complete.

16. Inthe dashboard, open the Placement tab and click on the Rotation Axis entry.

The model will display the geometry used to constrain the rotational movement of the
servo horn and a pop-out panel will list them including; maximum and minimum limits
and a Regen value.
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FIRST Tech Challenge

The purpose for the first two should be clear. The Regen value is useful for positioning

the joint when the model is regenerated.
17. Close the dashboard and sub assemblies
18. Erase models from memory

Servo feedback for DC motor

The Tetrix geared DC motor can be converted into a servo motor with the Tetrix encoder.

< -
= E
14 4 '
[ )

Tetrix encoder assembly instructions

This briefing is now complete.
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Briefing five - Mechanisms

Mechanisms are a logical next step to static assemblies. Mechanisms allow parts of your
assembly to operate in a mechanical sense. Mechanical movement is usually divided into

Mechanisms applied to FTC

The example robot provided in this project guide uses most of the components in the
Tetrix robot kit.

Before you look at the Pro|[ENGINEER mechanisms simulations you are advised to learn
about constraints and how to model mechanical assemblies. The following Online
Courses in PTC University Coach will help: http://schools.ptculms.com/

e Assemblies > Bottom Up Design

e Introduction to Mechanisms > Start with Overview and Creating Mechanisms
then Advanced Connections > Gear Pair Connections.

Understanding the basics will let you come back to take additional modules as you need
them.

In addition, PTC’s schools curriculum contains projects covering aspects of mechanisms
including:

e Starchaser Rocket(assembly and force motors)

e Scalextrc4Schools (assembly, force motors, slot connections, gear ratios,
efficiency)

Task one - Gearing

There are three sizes of gears in the Tetrix™ kit which we describe by the number of teeth
they have; 120T, 80T and 40T.

In the tutorial robot a set of three gears connect the DC motor to the large diameter wheel.



http://schools.ptculms.com/

DC motor
40T

Road wheel

From Briefing five we know the DC motor rotates at 924 degrees per second so, using a
little math we can work out the rotational velocities for each of the gear pairs.

40T — 120T gear pair

For this gear pair the 40T gear is the driver and the 120T gear is being driven. The
formula for working out the rotational velocity is:

Driver Teeth x rotational speed Driven teeth x rotational velocity

40 x 924 = 120T x?
40 x 924 = 2
120

120T Rotational speed 308 degrees per second

120T - 80T gear pair
The 120T gear now becomes the driver and the 80T is the driven gear.

Driver Teeth x rotational speed Driven teeth x rotational speed

120x308 = 80T x?
120x308 = ?
80

80T Rotational speed 462 degrees per second

This same equation could be used to work out the angular velocities of any gear pair.
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Interrogate gear pair connections.

1. Pro|ENGINEER should be open with
no models on screen and none in
memory.

2.  Set the working directory to
\FTC_Robot\Gearing.

3.  Open the assembly
DRIVE_TRAIN_SUB.ASM

Many of the components and some sub
assemblies have been hidden to make it
easier to interrogate the mechanism.

4. Hold down Ctrl+Alt then drag the perimeter of the small gear to test the kinematic
movement.

5. Inthe main toolbar across the top of the screen click on Applications then select
Mechanisms.

The model will display symbols showing mechanical connections, motors, etc and a new
mechanisms panel will appear below the model tree.

1= DRIVLE_TRARM_SLE [Active] - ProlfMEHLER Scheals Lditon [far educational use only)
Fla Edt Vaw luwart Arebain bfa Acgicslioos Tool Windew  Hek
=K PREBn - y@ArEnaa@ANs 0000
r & A =
"ri ‘ma e W7

A rowuma befan to abort ared Brish draggingg

el il e o dr u
JEEED % &
I _sheee = || Semngi= i
>R,
| EHOTVE_TRAIH 518 A58 A &5 g
A A5 AGHT
£ AR TOR 1
£ AEM FROMT

= A CEF T

+

+
f -

B MECHAAEH
BEODHES
B RN
S [k COAMECTIONS
# Tt s
= 5 S
= W P (TSIVE_TEAIN_SUE)
5 Bl GamPalry TEINT_TEARN_SUN o
5 . GasrPairs (DS IVE_TRAR_SUB
# THOTORS
[T
i DePERT
B FORCESIISGES
J ITIAL CORDETICNS
X awermes
b PLATESCTS

T % e ey s

&
L o

-

e frwan wo

PTC — www.ptc.com page 59 of 116



Pro|ENGINEER Wildfire 4

6.

In the mechanisms panel, click on the
+ next to CONNECTIONS to expand it.

Expand the GEARS entry and you will

see several gear definitions.

8. Left Click tj on one of the gear
entries and you will see the gear
definition symbols highlighted on the

model.

The illustration here shows the gear

connection between the large idler and the
gear driving the rear wheel.

9. In the mechanisms panel, right click on

the gear connection and, from the
floating menu, select Edit Definition.

10. The Gear Pair Definition dialog will
open and the model will display
geometry used to define the gear pair.

Each gear definition has three tabs one for
each of the gears in the connections and a

Properties tab.

FIRST Tech Challenge

11. Click on each of these tabs and note what is highlighted on the model.

Note: In this diagram the three tabs are shown side by side. In practice you will only be
able to view one panel at a time.

B Gear Pair Definition
Narw

Geafar!

Type

Stardasd v

Gearl Gon2 Propeties

Moton Ax

Nane

GearPar!

Type

Standaed v

Goxl Gea2  Propenes

Maohon Ax

IJ Connection_11.aes_1 E] Cornection_13 aes_1 [E
Body Body
Doy Ges
tedys 7- bod6 .
Canet ) Canmme [*‘J
Goound Grourd
:l‘ct Crcle Pich Cacle
Darets Disrretes
€0 e 120 st
con Locahr lcon Locadon
LY 0y
o< | [ Caral
[ oK | [Aeph | [ Cancel] . J Loy ) [Corcn]

m B Gear Pair Definition R ¥ Gear Pair Definition g

Name
GeuPan

Type
Standwd v

Geal | Gea2| Properties

Gear Rado

Pich Crcle Diameter ~
o) D2

Camer Body

(Lox | (ool | [Concel]

PTC — www.ptc.com

page 60 of 116



The gear ration is defined by the two numerical values; 60mm /3.15 in for the Gearl tab
and 120mm / 4.72 in for the Gear2 tab. Although these are labeled as mm/in, these are
not absolute values. They represent the ratio between the two gears. In this example we
used the number of teeth on each gear.

The third tab provides a ‘user defined’ method of defining gear pairs as a ratio. If this were
used we can enter simple numbers like 1(40T) 2(80T) and 3(120T).

@ Note: You may want to try the analysis which drives the gears for 1 second.

12. Close any dialogs and models then Erase not displayed.

Task two - Torque

Torque or turning force is important in
robots because you need a certain amount
of torque to turn the wheels to make things
move.

Force (F)

Another name for toque is moment and they
are made up of a force and a distance from  Fulcrum
the axis or fulcrum of a rotating object.

Torque (T) = distance(r) x Force (F)

Metric (mm) ANSI (inches)
Force in Newtons (N) Force in pounds (Ibf)
Distance in meters (m) Distance in feet (ft)
Moments in Newton Meters (Nm) Moments in foot pounds (ft Ibf)

Motor torque

Motors in the Tetrix™ kit have a published torque at the output shaft. Appendix two and
three are copies of the manufacturer’s data sheets for the servo and DC geared motors
respectively. Taken from the data sheets, here are the published torque values for the two
motors with examples.




Device Metric ANSI

Servo motor 4.3 kg.cm=422Ncm 60 in ozf = 3.75 in Ibf
Stall torque (4.8v)

DC geared motor 325 in ozf = 20.3 in |bf

Stall torque (12v)

@ Note: the data sheet for the DC motor only gives metric information. The torque
figure was converted using http://www.unitconversion.org/

Torque applied to FTC

We can use this information entered into Pro|ENGINEER models to help design FTC
robots. To demonstrate this you will use a model of the servo motor rotating a mass
against the force of gravity. The model you will use has been simplified. In practice there
would be an arm or beam connecting the load to the servo.

Servo motor torque
1. Start Pro|[ENGINEER.

2.  Set the working directory to
\FTC_Robot\Moments.

3. Open the assembly
Lifting_a _mass.asm

4. Rotate/zoom until the model looks like
this.

5. Hold down the Ctrl + Alt keys and, with the Left mouse button @ held down, drag
the red load to explore motion in the assembly. Take special note of the limits of
movement.



http://www.unitconversion.org/

A cylindrical object is assembled to the output shaft at a certain distance from the axis to
act as a ‘load’ on the motor. The mass of this object has been carefully set just greater
than the torque capability of the motor.

The servo motor has a ‘Force’ motor applied which will move the output shaft with a
defined torque.

Interrogate the model

Before running the analyses we will interrogate the model to find the mass of the load, how
far it is from the pivot and the torque of the servo motor.

Knowing this information we will ask you to predict what will happen before the analysis is

run.

@& ¢

10.

11.

12.

In the model tree right click over the part

LOAD.PRT and from the floating menu select Arslysis | Featurs
ACt'Vate ’ CSYs Select items
In the Main toolbar open the Analysis pull-down L4 Tkoliars
text menu, click on Model and then Mass Densiy
Properties. Acouracy 0.00001000 v
In the Mass Properties dialog, click on to VOLUME = 55069167e+04 MM"3 A
perform the analysis DENSITY - 7 83708306 08 KIL OGRAM
MASS = 4.3103088e-01 KILOGRAM
Note: The metric mass of the part is 0.431 kg. CENTER OF BRAMITY ith respect o _L
. INERTIA with respect to _LOAD coordinal
Note: The ANSI mass of the part is 0.96 Ib. . Y
Guick v
. : e’
Click to close the dialog. B
In the model tree Right-click Ej over
LIFTING_A_MASS.ASM and from the floating
menu select Activate.
{ Mate

In the model tree Right-click Ej over
the LOAD.PRT and from the floating A vy
menu select Edit Definition. |

The assembly constraints will preview
and show the center of the load is
located 100mm/3.95 inches from the
axis of the servo.

Click to close the assembly T~




dashboard or middle mouse click.

A quick calculation shows the turning force or torque the load will place on the servo:

Torque (T) = distance(r) x Force (F)

Metric ANSI
r=100 mm r=3.95in
F =0.431 kg x 9.81 = 4.23 Newtons F = 0.96 Ibf
T=rxF T=rxF
T=100x4.23 T=3.95x0.96
T =423 N mm T=3.8inlIbf =60.7 in 0z

If we now look at the torque programmed into Pro|[ENGINEER for the servo motor:
13. Inthe Main toolbar open the Applications menu and select Mechanism.

14. In the mechanism tree, expand MOTORS and FORCE then Right-click Ej over the
entry Force-turning (LIFTING_A_MASS).

15. From the floating menu, select Edit Definition

The Force Motor Definition dialog opens.




Metric ANSI
m = Force Motor Definition %]
MHame Mame
| Force-turning | | Farce-tuming |
kation Axis M atian Axis
|8SERVD_ERVO) Connection_1.axis_1| [ & | l815ERVD_ERVO ) Connection_1.asis_1|
t agnitude Magritude
l./;f || Caonstant v Imm M | I./;J || Canstant v Iin [a]3 |
A .
Wariable Yariable
l QK ] [ Apply ] [Cancel] l QK. ] [ Apply ] [Cancel]
@ Note: The value is the same as the % Note: The value is the same as the
data sheet (4.3 kg cm) but expressed data sheet (60 oz in) but expressed as
as millimeter Newton (mm N). inch pound feet (in Ibf).

16. Left Click tj Close to close the dialog.

Prediction
What would you expect to happen if we start the analysis in the following situations?
e Starting with the load horizontal?

e Starting with the load vertical?
Make a note of your prediction then carry out the analyses that follow.

Torgue simulation

17. Change the view to Trimetric.
18. In the Mechanism tree on the left of
the screen expand the ANALYSES
heading
\, D
\S ('_To

19. Right-click O onthe X
Horizontal _start entry and, from the
floating menu, select Run

The mechanism will be analysed and a
playback created.




20.

21.

22.

In the mechanism tree PLAYBACK section, Right-

Frame
click @ over the Horizontal_start entry and select DJ ; -
Play NN N
In the mechanism tree expand the PLAYBACK KR M Hd» l
heading and Play the simulation several times until — P
you can describe accurately how the mechanism -
moves.

Note: You can rotate and zoom while the movement is
playing back

Now try to explain why the mechanism moves in this
way.

You should have recognised the torque from the servo motor acting clockwise is just less
than needed to overcome the torque from the load. This assumes a static situation which
is why the analysis started with the load stationary at the horizontal position.

The next analysis would seem to contradict what you have just seen and suggest there is
enough torque in the motor to overcome the load.

23.

24.

25.

Pro|[ENGINEER is able to simulate the
dynamic movement of the mechanism

In the mechanism tree ANALYSES
section, run the entry Vertical_start.

Once the analysis has finished, use
the PLAYBACK controls to replay the
movement watching how the
mechanism moves.

Describe what you think is happening
and why it is behaving like this.

helping us understand what is happening.




At the start of the analysis the servo is able
to rotate the load as gravity is acting
vertically down and servo torque is acting
sideways.

The servo is able to accelerate the load
adding kinetic energy or inertia due to its
mass and velocity. This is sometimes
called ‘flywheel effect’.

As the load approaches the 9 o’clock
position, the force of gravity on the load is
now opposing the servo torque. The forces
don’t balance so there is a net downward
force decelerating the load.

However, the kinetic energy in the load is
enough to carry it past the 9 o’clock position
where it begins to accelerate again.

The load comes to a sudden stop because
the servo only has 180 degrees of
movement and this is the limit of rotation.

Pro|ENGINEER has additional analysis
tools including the option to ‘measure’
parameters and graph them dynamically
while the playback is being viewed.

This model has a force arrow showing
angular velocity. During playback force
arrows change size and direction.

Here we have playback with two graphs
showing rotational velocity on the left and
rotational acceleration on the right.

Vertical_start (Cynamic)

(i) <X nid ais (1% ols [ 1] 0a5 g
Timie Sac)
“emicd_sart:Retaieed Velociny degted

Accelerating

Decelerating

Accelerating

Vertical_start (Dynamic)

| I ] ettt

L 0,05 Qi 018 (1] 11 030 n3s 044
Tirme (Sac)

Wenticd_satmeasee] Heglee"l

26. Open the File pull-down menu Left Click @ Erase and from the floating menu

select Current.




This closes the current model and removes files from memory.

This has only touched on the powerful tools for mechanisms dynamic simulation and
analysis in Pro|ENGINEER.

To learn more about these tools in Prol[ENGINEER go to PTC University Coach at:
http://schools.ptculms.com/cadtrain/coachims/client/login

Try out the online Pro|ENGINEER courses under the heading:
e Introduction to Mechanism.
e Mechanism Simulation using Pro/ENGINEER Wildfire 4.0

This briefing is now complete.



http://schools.ptculms.com/cadtrain/coachlms/client/login

Pro|ENGINEER Wildfire 4 FIRST Tech Challenge

Briefing six - Movement and control

You will now learn about the geometry of movement and how math can be really helpful
when designing your robot and programming its movement.

The simplest form of instructions used to program robots switches motors on for set
periods of time.

For example: Labview example
Ele Edt View Project QOperate

C START )
RCLIDIE

Motors A&B on S

P ex1.vi Block Diagram

Wait 5 seconds

!

Motors A&B off 3
!
C End )

To help with programming we need to know how far our robot will travel in a set period of
time. To find this out we could build the robot and drive it for a set time measuring how far
it travels.

However, what if you haven’t built the robot yet? Pro|ENGINEER has sophisticated
measurement and simulation tools we can use with the component specifications to get an
accurate prediction how the finished robot will perform.
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Pro|ENGINEER Wildfire 4 FIRST Tech Challenge

Task one - Wheels

Let’s take a look at a single wheel and work out the relationship between diameter and
distance travelled.

Speed and distance

Find the large wheel in the Tetrix™ kit and guess how far it will travel in one revolution.
The wheel traveled the distance around the circumference of the wheel.

There are several ways we can find this out;

Experiment

Make a mark on the rim of the wheel.
Place the mark over a line on a piece of paper.

Carefully roll the wheel in a straight line along the paper until the mark on the rim
reaches the bottom again.

Make another mark on the paper.

5. Measure the distance between the two marks on the paper. This is the
circumference of the wheel.
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Measuring

6. Wrap a flexible tape measure around the outside of the wheel. If you don’t have one
of these use a piece of string then measure it with a normal ruler.

Geometry
7. Measure the diameter of the wheel using calipers then use the formula:
Circumference = 11 x diameter

For the large Tetrix™ wheel the diameter is 4” or 200mm so:

Metric (mm) ANSI (inches)
Circumference = 3.14 x 100 mm Circumference = 3.14 x 4”
Circumference = 314 mm Circumference = 12.56”

Velocity across the floor

We can now combine this information with the speed of rotation from briefing five to find
out how far the robot will travel each second. To do this we will use the formula:

Velocity along the floor =  Circumference of tire x Revolutions

The wheel revolves 454.5 degrees per second which is:

454.5 = 1.26 revolutions per second
360

So the distance travelled in one second is:

Metric (mm) ANSI (inches)
V = 314x1.26 mm V = 1256 x 1.26 mm
V = 395.64 mm V = 15.83inches
Velocity = 400 mm sec™ Velocity = 16insec™




Distance travelled

We can now create a formula to predict how long we need to run the motor for to travel a
certain distance. This will help us plan accurate programs for the electronic controller.

Time (T sec) required to cover the required distance (D mm/inch)

Metric (mm) ANSI (inches)
T = D T = D
395.64 15.83
E.g. to travel a distance of 1500mm: E.g. to travel a distance of 54”:
T = 1500 T = 54
395.64 15.83
T = 3.79 seconds T = 3.41 seconds
In practice!

Theory is all very well but there are several reasons why the robot may not behave exactly
as planned including; friction, motor variations, inertia, floor surface variations, etc.

Task two - Friction

Definition: ‘Friction is a force that opposes motion‘.

e Friction is greater for rough surfaces

e Friction varies according to the materials e.g. low friction materials like PTFE are
used for some bearings and high friction rubber is often used for tires.

e Friction increases as the pressure between surfaces increases — e.g. axles that are

tight in a bearing; heavy vehicles.

e Friction is not affected by the area of contact between materials.

e Coefficient of friction is the unit of measurement and is different for each pair of

materials and the surface finish of both.

Friction coefficients depend on the type of materials in contact. Tables of typical friction
coefficients are found in physics and engineering texts.

There are two types of friction:

e The coefficient of static friction (4s) describes the amount of energy that is

needed to initiate movement in your model.

The coefficient of kinetic friction (uk) describes the amount of energy that is lost
to friction while keeping your model in motion.




% Note: The coefficient of static friction for two surfaces must be equal or larger than
the coefficient of kinetic friction for the same two surfaces.

Friction applied to FTC

Pro|ENGINEER can simulate the friction between the wheels and floor but first we need to
know the coefficient of friction between the robot wheel and the ramp surface.

Coefficient of friction
Coefficient of friction is an empirical value and so can only be found by experiment.

This is easily found by measuring the force needed to pull the robot along a horizontal floor
surface combined with the mass of your robot. This illustration shows a force meter being
used to pull the robot.

Mass (m)
o ~ 3‘ . ey O
O O Pulling force (Fy)
Weight (Fy)

Force to keep the robot moving — Readings should be taken when the robot is moving
steadily across the surface.

Force to start the robot moving — This is harder to measure unless you have a force
meter with a marker which records the maximum reading or data logging equipment with
force sensors to measure the two values for coefficient of friction.

With these values we can now calculate the coefficients of friction for our robot.

Example: FTC robot pulled along a carpeted floor.

Metric (mm) ANSI (inches)
Mass of FTC robot = 3 kg Mass of FTC robot = 6.6 Ibs
Weight = Mass x gravity Weight = Mass x gravity
Weight = 3x9.81 Weight = 6.6 x9.81
Weight (Fy) = 29.43 Newtons Weight (Fy) = 64.751bf

Pulling force (F) = 20 Newtons Pulling force (Fy) = 4.41bf




Coefficient of Friction () Coefficient of Friction ()

Ff = uxFEN Ff = uxFy
20 = ux29.43 43.164 = px64.75
20 = 43.164 =
29.43 64.75
068 = p 067 =

The coefficient of friction will be used next to program the Pro|ENGINEER model when
analyzing movement.

@ Note: When simulating your FTC robot, it is very important you measure the friction
on the same material the arena floor is made of.

The 2009 FIRST Robotics Challenge (FRC) arena has a low friction surface to simulate
the low gravity moon environment. On low friction surfaces like this the wheels may slip
and slide.

If your team enters the FRC you should find out the coefficient of friction between your
robot and this low friction surface then use this to analyze the movement of your robot.

Friction applied to control

If the wheels of a robot driving over this surface slip would this interfere with control
program? Would it help to know how much slip there has been? Could you use feedback
sensors on the wheel spindle?

Can we measure velocity across the floor surface? Could you put sensors somewhere
else to ensure the correct distance is travelled and build this into the control program?




Example: Labview

C START )

EE%

P ex3.vi Block Diagram

Move a distance
A R rM_s-,u-wce.-..
No '
Distance 1

aChieved?/
Yes
C End )

Would it help to know how much slip there has been?

Could you use feedback sensors on the wheel spindle?

Can we measure velocity across the floor surface? Could you put sensors somewhere
else to ensure the correct distance is travelled and build this into the control program?

Moving in a straight line

No matter how carefully the motors are manufactured the chance that any two run at
exactly the same rotational velocity are slim. The visible outcome of this is a robot with
tank drive like ours travelling in a slight curve rather than a straight line.

An innovative solution to this can be found
in the drive system of a toy sold by Milton
Bradley in the 1980s called Big Trak™.

This had permanent magnets on the motor
shafts which locked together when the
motors were running at near the same
speed. More information about these
innovative toys can be found on the web.

http://www.thebigtrak.com/gallery.htm



http://www.thebigtrak.com/gallery.htm

http://www.thebigtrak.com/legacysites/robotprojects/ - disassembly instructions showing
magnetic clutch after step 10.

Task three - Inertia
Definition ‘Inertia is an objects resistance to changes in velocity’.

Anything with mass resists being moved or accelerated, this is called inertia. The mass of
an object determines how much inertia is has, i.e. the greater the mass of an object the
more inertia it has.

Inertia is why engineers try to reduce the mass of objects that move such as pistons, cars,
rockets and aircraft.

~' : 1 r
i\\xa, S X Nﬁ?ﬁ
\ Qp )‘A]J - / 7
A 0}
A small (light) car is easy to push... ...while a large (heavy) truck is impossible to push

Inertia applied to FTC

The FTC robot weighs the same as three bags of sugar so inertia must be considered.
After switching on the motors it will take a little while to accelerate to full speed.

We will simulate this using Pro|ENGINEER first using Earth gravity then using Moon
gravity to see if this makes a difference to the motion.

1. Pro|ENGINEER should be running Tiwe: 0.00
with no models on screen or in . i
memory. . 5}

2. Set the working directory to L '
\FTC_Robot\Inertia O O

3.  Open the model INERTIA.ASM

4

Change the view to FRONT and zoom
to see this.

The next analysis is configured to last 0.25 seconds with a frame rate of 100 to capture the
motion in detail. Cam connections between the wheels and the floor have liftoff (0.5) and
friction (0.68) enabled.

5. Inthe main toolbar open the Applications pull-down menu and select mechanism.



http://www.thebigtrak.com/legacysites/robotprojects/

6. In the mechanism tree expand the ANALYSES heading and Right-click Ej over the
Inertia (DYNAMICS) entry then select Run.

% Remember: The analysis is mathematically complex and does not take place in real
time. It may take longer than 0.25 seconds to finish.

Saving a playback

7. Inthe model tree, listed under PLAYABACKS you will now see a new entry.

8. Right-click Ej over the new entry and, from the floating menu, select Save.
9. Type a name for the playback and click Save.

10. Replay the analysis and zoom in to look at the first part of the simulation. You will
see the wheel spin for a short time until the robot is moving.

We will now change the force of gravity acting on the model.

Metric (mm)
Earth (g) = 9.806.65 m sec?
Moon (g) = 1.635 m sec?

ANSI (inches)
Earth (g) = 32.2 ft sec” = 386 in sec?
Moon (g) = 5.37 ft sec®= 64.44 in sec®

11. Inthe mechanism tree Right-click Ej over the JL"E'FGravity entry and, from the

floating menu, select Edit Definition.

Metric (mm)

12. Change the Magnitude to 1635 then
click (K],

b agnitude
1634

Direction
o0
o)A
2|0

ANSI (inches)

8. Check which units gravity is being
measured in then change the
Magnitude to 5.37 or 64.44 then

click (2%,

bd agnituide
R.3T

Direction
|0
|-
2|0

13. In the mechanism tree Right-click Ej over the Inertia (DYNAMICS) entry and select

Run.




Pro|ENGINEER Wildfire 4

14.
15.

FIRST Tech Challenge
Save the Playback.

Replay the analysis and zoom in to look at the first part of the simulation. You will
see the wheel spin for all of the analysis with the robot moving a much shorter
distance.

® Below is a graphic representation of the total movement in 0.25 seconds plus graphs
in Pro|ENGINEER measuring the position and velocity of the robot.

frdrifrdaifinfeiial <o o
| | -, Pt & i

T

§
|

Time: 0.25 Time: 0.25

1= Graphiosl ] 1= Graphissl DX
Fis Wen Fomst M ‘Wen Fomat
o HEasE » o HEaiE B
Slope_slip (Dyvnamic) Slope_slip (Dynamic)
400,008 250, 00
B0, T
- 200,00 —]
300,00 ]
250,00 ] 150,00 __Nevm—tioipgmrsgr g
g 00,00 |
150,00 g 100,00 ]
100,00 ] T
i 50,00 |
.00
e S e B T T
[l ] 005 oia R 1] a0 0I5 fale} 05 oia s 00 0I5
Time {5 e} Time {5ec)
Hope_slipaPoaition (mm) Sope_slipzPeosition fmm)
Slope_slipzVebociy (mm fosch Stope_slipsVelacioy (mm f sec)
et s Semcrin e

On the left we have Earth gravity where the robot accelerates for a little over 0.05 seconds
reaching full velocity of 400 mm sec? for the rest of the analysis.
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On the right, using Moon gravity, the wheels were still slipping and the robot still
accelerating when the analysis ended at 0.25 seconds. The maximum velocity at the end
of the Moon analysis was only 160 mm sec? and still increasing.

@ Note: The vertical scale is different between the two graphs. The maximum value on
the Earth (left) is 400 mm sec® whereas on the Moon (right) the maximum velocity is
250 mm sec?.

16. Close all dialogs and models then Erase not displayed.

Task four — Turning
Turning a robot of this design can be done in two ways.
e Spin on the spot with wheels driving in opposite directions.
e Turn with the wheels on one side driving and the other side stationary.

Spin
‘Skid steer’ is the term used to describe — T
. . . — *-l I ol

turning with a robot of this type. If the '_"“j = el N Y
wheels on one side are turning forwards i L= S
while the other side is in reverse the robot == B e ‘-’::}ﬂj

. . . . - - ' .: 1 I __':'\’::'H'“" ;“'x & .l'!::"".
will spin on its axis. | 1_: [ i ey fff_., P*..'?-sf

i

http://www.terexvectra.com/

We can use math to work out the geometry of the arrangement and how long we have to
turn on the motors to achieve a specific angle spin. First we need to use the measurement
tools in Pro|ENGINEER to find the track width of the robot.

1. Pro|ENGINEER should be running with no models on screen or in memory.
2.  Set the working directory to \FTC_Robot\Turn




Open the model Spin.asm
Change the view to TOP
In the model tree expand the entry for ROBOT_GAME.ASM

o 0 s~ w

Drag the ¥ Insert Here fiag to below the two DRIVE_TRAIN_SUB.ASM entries

(7] 5PIN.ASM
/7 ASM_RIGHT
£7 ASm_TOP
/7 ASM_FRONT
%¥x ASM_DEF_CSYS
# (] FLOOR_SMALL.PRT
= [L) DROBOT_GAME.ASM
/7 ASM_RIGHT
/7 ASM_TOP
{7 ASM_FRONT
-}S ASM_DEF_CSYS
7 oaaL
/7 TRANSVERSE
£7 LONGITUDINAL
/' VERTICAL_CENTRE
+ (L) DRIVE_TRAIN_SUB.ASM
e _]DRIVE TRAIN_SUB.ASM
# Insert Here!
J *STANDOFF_2_INCH.PRT
() "STANDOFF_2_INCH.PRT

] 'STANDOFF 2 INCH PRT
288MM PRT

7. Inthe main toolbar across the top of
the screen open the Analysis pull-
down text menu and select Measure >
Distance

ASM_FRONT

‘A»

N219.287 DISI /\'\(I

. g ‘
SM_FRONT

\

8. Make datum planes visible and all
other datum features invisible

9. Select the ASM_RIGHT datum planes
for one pair of wheels on opposite
sides of the robot shown here in red.

The distance will be shown on the model
and a dialog will open reporting the selected
geometry and the track of the robot.

5\1 _FRONT

Metric (mm) ANSI (inches)




Pro|ENGINEER Wildfire 4

= Distance

Analysis | Feature |

From

To

Projection
Direction

S
|Jpdate

ASM_RIGHT:F1[D.

Uze Ag Plane

ASM_RIGHT:F1 (DA

Uze Az Plane

Click here to add ite

[ Wiew Plane

Cartezian

Distance = 219.289

| Quick

W

[s_pisTance_1]

%]

v [x]

FIRST Tech Challenge

@ Distance |z| |

Analysis | Feature |

From

To

Praojection
Direction

C5YS
Update

A5M_RIGHT:F1[Da

lJze Az Plane

A5M_RIGHT:F1[DA

|Jze Az Plane

Click here to add ite

[ wiew Plane

Cartezsian

Distance = 863344

| Quick

»l|[5_DISTANCE 1]

2

v] [x]

10. Click to close the Distance dialog.
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With an accurate measurement of the track width we can now calculate the circumference
of the circle traced by the wheels when the robot spins.

I el IR

Circumference = 11 x diameter

Metric (mm)
Circumference = 3.14 x 219.29
Circumference = 688.57 mm

ANSI (inches)
Circumference = 3.14 x 8.63
Circumference = 27.1 inches

With this information we can work out how long the motors need to be on to turn the robot
a set number of degrees. We know how far the wheels travel in one second so how many

degrees turn does this represent?

Metric (mm)
Robot velocity= 395.64 mm sec™

Rotate = 395.64
688.57

Rotate = 0.57 of aturn
Rotate = 0.57 x 360
Robot rotate = 205 degrees

ANSI (inches)
Velocity = 15.83in sec™

Rotate = 15.83
27.1

Rotate = 0.58 of a turn
Rotate = 0.58 x 360
Robot rotate = 210 degrees

Why do you think there is a difference in the number of degrees in each column when the

robot is identical?

Look back to the diameter used for the wheels in each column. Is 4 inches exactly
100mm? Use an accurate measure like vernier calipers to check the actual diameter of
the wheels. You may want to substitute this in the previous formulae to get a more precise

outcome for your exact design.

Degrees of turn

We can now create a formula to predict how long we need to run the motors in opposite
directions to spin the robot a set number of degrees. This will help us plan accurate

programs for the electronic controller.




Time (T secs) required to spin the required R (degrees)

Metric (mm) ANSI (inches)
T = B = B
205 210
E.g. to spin 180 degrees: E.g. to spin 180 degrees:
T = 180 = 180
205 210
T =0.88 seconds = 0.86 seconds

Spin with Pro|ENGINEER

This model has cam connections between the wheels and the floor with liftoff enabled (0.5)
and static/kinetic friction enabled (1). The analysis runs the wheels at a constant 454
degrees per second for 0.44 which according to the calculations above should spin the

robot through 90 degrees.

11. Pro|ENGINEER should still be running the model
SPIN.ASM open on screen.

12. Change the view to Top to see this.

13. In the main toolbar open the Applications drop-
down menu and select Mechanism.

14. In the mechanism tree, expand ANALYSES and

run the analysis Spin_on_spot (DYNAMIC)
The robot will turn to this position.

If we were to measure the angle before and after the
analysis we would find the angle of spin is 86 degrees,
very close to the 90 degrees calculated previously.

The cam connections in the assembly use a value of 1
for coefficient of friction so it should be no surprise the
simulation so closely matches theory. Next you will
alter the value to 0.68.

What do you think will happen when the simulation is re-run?




15. In the mechanism tree, expand the CAMS I Cam-Follower Cannection Defini... ]

I are
Carmn Followerl

heading, then Right-click @ over Followerl

(Spin) and, from the floating menu, select Edit Comi | Cam2 | Propetes
Defl n Itl o n " ftlz:able Liftaff
16. Activate the Properties tab and change both ft =
Friction values to 0.68. then to close. o mietin
M3= 0.68
@ Note: This was the coefficient of friction found th - [0

previously by experiment.

17. Repeat this to change the coefficient of friction
for the other three cam connections.

18. Re run the analysis Followerl (Spin).
The robot model has not turned by the same amount.

Measuring the rotation would show the finishing
position is 67 degrees from the start.

Why do you think there is a difference?

This shows how accurately Prol[ENGINEER simulates mechanical systems and underlines
why Pro|[ENGINEER is the leading 3D parametric design software in the world.

Turn with Pro|ENGINEER

If the wheels on one side are turning while the other side is switched off the robot will turn
around the fixed set of wheels rather than spin.




The first thing we need to know is the circumference on the circle traced by the wheels
when the robot spins.

Circumference = 11 x diameter

Metric (mm) ANSI (inches)
Circumference = 3.14 x 438.58 Circumference = 3.14 x 17.26
Circumference = 1377.14 mm Circumference = 54.2 inches

With this information we can work out how long the motors need to be on to turn the robot
a set number of degrees. We know how far the wheels travel in one second so how many
degrees turn does this represent?

Metric (mm) ANSI (inches)
Rotate = 395.64 Rotate = 15.83
1377.14 54.2
Rotate = 0.29 of a turn Rotate = 0.29 of a turn
Rotate = 0.29 x 360 Rotate = 0.29 x 360
Rotate = 104 degrees per second Rotate =104 degrees per second

Unlike the previous spin calculations, the results for each of these columns are identical.
Why do you think this is the case? We rounded the values to two decimal places and by
coincidence this has brought the two results together.

This highlights the question common in all forms of design and engineering of how precise
do we need to be. Increased precision usually costs time and/or money.

The information provided by these calculations will be used to program the robot but when
it is running there may be bumps in the floor, slippery patches and the motors may be
operating slightly faster or slower. With this in mind we only need calculations within a few
percent of the required value. Fine tuning can be done once the robot is operating.




Degrees of turn

From this information we can now create a formula to predict how long we need to run the
motors on one side to turn the robot a set number of degrees. This will help us plan
accurate programs for the electronic controller.

Time (T secs) required to turn through A (degrees)

Metric (mm) ANSI (inches)
T = A T = A
104 104
E.g. to spin 180 degrees: E.g. to spin 180 degrees:
T = 180 T = 180
104 104
T =1.73 seconds T =1.73 seconds

Turn with Pro|ENGINEER

19. Pro|ENGINEER should be running with no
models on screen or in memory.

20. Set the working directory to
\FTC_Robot\Turn

21. Open the model TURN.ASM
22. Change the view to Top to see this.

23. In the main toolbar open the Applications
drop-down menu and select Mechanism.

24. In the mechanism Tree, expand ANALYSES = “ |
and run the analysis Turn (DYNAMICS) T ,n

The robot will turn to this position.

If we were to measure the angle before and after
the analysis we would find the angle of turn is 52 Fﬁ
degrees which is more than the calculated value

of 45 degrees!

The cam connections in the assembly use a
value of 0.68 for coefficient of friction so we
should expect there to be some wheel spin and
the turn to be less.

We are assuming the axis of turn is perfectly central between the stationary wheels. Due
to the center of gravity not being central the axis of turn is likely to be offset.

25. Close all models and dialogs then Erase not displayed to empty memory.




Task five - Inclines

So far we have assumed a level playing field. The arena has a range of surfaces your
robot must navigate and one of the features your robot must negotiate is a ramp.

Ramp

Two important things will determine how well your robot copes with a ramp; friction
between the wheels and the ramp surface, and centre of gravity (c of g). Both of these we
can simulate using Pro|[ENGINEER.

Slope climb - Friction

Earlier in this tutorial you conducted an experiment to measure the force needed to pull the
robot along a surface and used this to find the coefficient of friction for those two surfaces.
You will now use this to analyze the slope climbing ability of the FTC robot.

The next Pro|[ENGINEER model has flat floor inclined at an angle of 25 degrees with the
FTC robot half way up.

Cam connections exist between the wheels and the surface of the slope. Liftoff and
friction are enabled to simulate the point when the wheels lose grip and the robot should
slide backwards down the slope.

1. Pro|ENGINEER should be running with no
models on screen or in memory.

2.  Set the working directory to \FTC_Robot\Slope
climb\Slope_slip

3. Openthe model SLOPE_SLIP.ASM

Change the view to Trimetric and zoom to see
this.

Initially the slope is set at 25 degrees.

We don’t know whether it will climb or slip backwards
so the robot is placed half way up the slope.




5. Inthe main toolbar open the %TFC:QSIE?

Applications menu and select |& raviTy
Mechanisms = | CONNECTIONS
) # 1>+ 101MTS
i = &, CAMS
6. Expand I*CONNECTIONS and the o

(> Cam Follower2 (SLOPE_SLIP)

I +

.- R . + - (5 Cam Follower:

(=2 CAMS group then Right-click Ej 5 eﬁ;.,G‘EQES Follers (LOPESP)
over the first Cam Follower entry and Y ki
from the floating menu choose Edit 5 DAVPERS

definition. [ FORCES/TORQUES
& 77 INITIAL CONDITIONS

7. The Cam-Follower... dialog will open. 8 2, ANALYSES

4P PLAYBACKS
The first two tabs store the geometry selections for the two IE Cam-Follower Connection Defini... [&]
halves of the cam connection. ENamFe —
The third tab, shown here, stores the values for Liftoff, and P Er— - —
coefficient of friction. Litoff
Enable Liftoff
g =075
1 Friction
LIftOff Etnable Friction
The official term for this is ‘coefficient of restitution’ or how M = |08
much bounce there is between surfaces. Typical values M - [068
are:
Range =0-1
Rubber ball =0.9
Softclay =0.1

The coefficient of restitution for the FTC tire is:
FTC Rubber tire =0.75

Coefficient of friction

How easy it is to slide two surfaces across each other. From the previous section you will
know there are two values for coefficient of friction; Static (s) and Kinetic (pi).

Remember, coefficient of friction is an empirical value and so can only be found by
experiment.

Typical values plus the value for the FTC tire found earlier in this tutorial are:
Range =0-1'
Silicone rubber =0.9
PTFE (Teflon) =0.05

! In theory, coefficient of friction cannot be greater than 1. In practice, certain materials like some
silicon rubbers, dragster tires and adhesive tape can have a coefficient of friction higher than 1.




The coefficient of friction for the FTC tire is:
FTC Rubber tire =0.68

8. Click OK to close the Cam-Follower... dialog

9. Inthe mechanism tree expand

X ANALYSES then Right-click U
the Slope_slip (Dynamics) entry.

10. From the floating menu, select Run.

Pro|ENGINEER will use mathematics to
calculate the vectors and forces acting on
the model and store the movements for later
playback. You should see the progress of
the one-second analysis reported along the
bottom of the screen but not in real-time.

% Note: The analysis may take quite a
time to complete.

The robot will move forward up the incline < e ‘.
; . ®
driven by the wheels. =

11. Inthe mechanism tree expand the

PLAYBACK heading, Right-click y ! ‘ s
over the Slope_slip entry and, from il ¢
the floating menu, select Play. s ¥ - I

12. Re-play the analysis zooming in on
the start to see if there is any wheel
spin or wheelie.

Increase slope angle

We can now increase the slope angle in the original assembly and then re-run the
analysis.

Ej (T] SLOPE_SLIP.ASM
13. In the model tree, Right-click over £7 ASM_RIGHT
RAMP.PRT and from the floating g 22:_;R°;NT
menu select Edit Definition. ;;.ngSM:osF_csvs
7 AA_L

R JRAMP.PRT

+ (L] BROBOT_CLIMB.ASM
& Insert Here
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14.

15.

In the Assembly dashboard, open the

Placement tab and Left Click Ej to
select Align Angle.

Change the Offset value to 30
degrees.

The angle of the amp will change in the
assembly.

16.

17.
18.

19.

20.

Click on to close the dashboard.

Change the view to FRONT.
Hold down Ctrl + Alt and hold Middle

mouse @ and drag the large center
gear to reposition the robot on the
ramp near the middle.

In the mechanism Right-click 6 the
Slope_slip (Dynamics) entry.

From the floating menu, select Run.

This time the wheels on the robot will
rotate trying to move up the ramp but the
robot will slide backwards.

FIRST Tech Challenge

= el [Lze Defned | [#] Consisari E nabbed

g

g Cowutrant Type -
P [
L) RAWP-TOP-FADATUM

Dl

B 45m_TOPFADATUM F
" Angle Oliset wibin e

Mem Coratimnt

Hirws Sl Slahm
Fully L ow'eidi darviad

Align Angle
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. . '0..‘
N
21. Use the PLAYBACK again to re-play fme 820
the analysis. "
. e
°
This time closely examine the start of the e . I

analysis to see the robot accelerate down
the slope despite the wheels trying to climb.

Saving playbacks
You may have noticed Playbacks are lost when a model is closed and reopened.

22. Move the mouse cursor over the PLAYBACK entry Slope_slip and Right-click Ej .
23. From the floating menu select Save.

24. Complete the dialog and click on [Sae [, By default the playback will be saved in
the working directory.

Opening playbacks
Next time you open the assembly;

25. Change to Mechanisms

26. Right click over PLAYBACKS then vYeOXFe

select Play... .,
27. Atthe top of the Playbacks dialog click [ Colison Detecion Satings.. ]

on = then select the saved playback ovs Schedde | Disley ‘mom

file and click [Oeen T[] =rondindi
28. In the Playbacks dialog click on 4¥ to

open the playback controls panel.

Task six - Centre of gravity

Briefing three mentioned c of g when talking about stability. The c of g is an imaginary
point where the mass of the object can be considered to act. Pro|ENGINEER can tell us
exactly where the c of g is in a model.

1. Pro|ENGINEER should be running with no models on screen or in memory.
2.  Set the working directory to \FTC_Robot\Slope climb\Slope_tumble
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3.
4.
5.

Open the model SLOPE_TUMBLE.ASM
Change the view to FRONT.
In the model tree, move the mouse cursor over the entry ROBOT_CLIMB.ASM then

Right-click 6 and, from the floating menu, select Activate.

In the main toolbar open the Analysis pull-down text menu choose Model then Mass
Properties. The Mass Properties dialog opens.

Select to carry out an analysis. The dialog now contains a range of information
and the model displays a coordinate system showing visually the ¢ of g position here
outlined in red.

£ [Mass Properties X

Andyss | Foshue

oS [ Selectitems_
[¥] Use Defauk

Densty

Acouasy 0000071000 v

= e 2
O —— " . ) Ul - 006 M
$rdeiRedsiapm 3 AVERAGE DENSITY = 3 E608538e+01 KILOGRAM / MM 3 ‘
24t it ‘ : D M4SS = 183232430403 KILOGRAM

‘ CENTER OF GRAVITY with respect to_SPIN cosednate frare
XY Z 28734103401 35033105:01 7.34317236-00 MM

INERTIA with respect to _SPIN cocrdinate hame: (KILOGRAM * MM~2) v

[
< )‘ﬂ

Quack

v M |
1 X]

Notice the c of g is not in the centre between the two wheels? Why do you think this is?

Gravity acts downwards so if the ¢ of g moves outside the base, the robot will topple over.
This is shown in the diagram below with the robot on a slope and about to topple over.

Gravity acting downwards from the c of g is in line with where the lower wheel contacts the
ramp.
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If the robot were facing up the ramp would the model be more or less stable? The position
of the robot arm will affect the ¢ of g and needs to be considered when tackling this
obstacle.

Slope climb - Tumble

The mechanism dynamics tools in Pro|[ENGINEER will now be used to demonstrate
stability and find the steepest slope the FTC robot will climb.

The slope has been set at an angle of 30 degrees.

The robot model is very similar to the previous example with cam connections between the
tires and the slope surface with liftoff and friction enabled. The coefficient of friction for the
cam connections has been set to 1.

8. What effect do you think this will have )
. . 4 -
on the simulation? 7 o
9. Change the view to FRONT and zoom O . ~
in like this. O ’
10. In the main toolbar open the S2 MECHANISM
Applications menu and select # igziﬁﬁv
Mechanisms. # |- CONNECTIONS
)]
11. Inthe mechanism tree expand ’;’:: Zﬂﬁzz
% Ej $¢ DAMPERS
22 ANALYSES then Right-click (#- FORCES/TORQUES Ed‘I‘ Definkion
+ ) INITIAL CONDITIOI Delete
the Slope_tumble (DYNAMICS) L3 anavvses o
entry. i\; Run
12. From the floating menu, select Run. o imrems et it »
Pro|ENGINEER will use mathematics to "
calculate the vectors and forces acting on <
the model and store the movements for later
playback. You should see the progress of
the two-second analysis reported along the e
bottom of the screen but not in real-time. , ‘
The robot will begin to move forwards up O
the incline driven by the wheels. The robot . - o
will wheelie until the gripper contacts the j=

floor and, after some bouncing, the robot ,
will climb the slope on its rear wheels with
the gripper dragging behind.
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13. Use the PLAYBACK again to re-play
the analysis.

Closely examine how the gripper contacts
the slope.

Optional extension
Explore the coefficient of restitution (liftoff) between the gripper and the slope.

e Change Cam Follower 3 connection (gripper end to slope) Properties > Liftoff () to
0.25

¢ Re run the analysis
¢ Look at the playback to observe how the gripper now bounces on the floor.

This briefing is now complete.
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Briefing seven - Systems and control
Control systems can be divided into two main types; open loop and closed loop.

Imagine your parents have told you to go to your bedroom. You leave the living room but
they cannot be sure you have reached your room; instead you may have gone to the
bathroom. This is open loop control.

C START )

Go to your room!

=

Imagine there was a video camera in your bedroom giving your parents feedback on
whether you had reached there? They might keep issuing instructions until you comply!

C START )

“Go to your room!”

A

No
Reached room?

=

Aren’t you glad parents don’t use feedback all the time?
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Labview

The labview control programs to achieve the examples above look like this.
Open loop

Closed loop

P ex1.vi Block Diagram

P ex3.vi Block Diagram E|E|E|
Ble Edt Vew Broject Operate Toos Window

NT _SyncDistance. v

m il

NXT_TouchSensor.vi

These examples are reproduced with the kind permission of Enable Training and
Consulting, Inc. Their LV Mastery courses are available online to all FIRST Tech
Challenge Teams and cover all aspects of the LabVIEW control systems.

Teams can visit www.LVMastery.com/Curriculum to register and find out more.

This briefing is now complete.
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Briefing eight - Engineering drawings

If you would like to learn about engineering drawings, often referred to as ‘detailing’ take
the following Online Courses in PTC University Coach: http://schools.ptculms.com/

e Detailing

e Advanced detailing

In addition, PTC’s schools curriculum contains projects covering aspects of detailing/
engineering drawing including:

e Sports drink bottle (Engineering drawings)
e F1in schools D Type (Engineering drawings)

Focus:

An effective method of communicating designs to other people is via the use of drawings.
Pro|ENGINEER allows designers and engineers to quickly produce engineering
production drawings directly from the solid model.

To help engineers interpret drawings anywhere in the world standards for presentation
have been created. Historically every country had its own set of standards such as British
Standards but these have been confined to the major continents. Examples include ANSI
from North America and 1SO, widely used in Europe and the Far East. In future we may
end up with one set of global drawing standards. Pro|ENGINEER can format drawings
for any international standard.

In the past, paper drawings have been the traditional, manual method of communicating
product design information but the use of solid modelling has allowed a more direct and
automated link.

Using drawings requires the engineers to interpret 2D orthogonal views whereas the 3D
solid model contains more information and is easier to visualise. The use of Computer
Numerically Controlled (CNC) machines now allows engineers to produce components
directly from the solid model.

This level of automation means that orthographic drawings are now mainly used to provide
overall dimensions, assembly details and inspection information.

During this briefing you will have access to a PC running Pro|ENGINEER Wildfire 4.0 and
learn how to create engineering drawings from an FTC robot including dimensions and
annotations.

Drawings and FTC

A key role for drawings in FTC is to communicate the design and operation of your robot to
the judges. We will focus on this to produce a general assembly drawing with orthographic
views containing key dimensions and a pictorial representation.



http://schools.ptculms.com/

Task one - Creating a drawing

1.
2.

Start Pro|[ENGINEER.

Set the working directory to where your own FTC
robot design is located.

Open your FTC robot assembly in
Pro|[ENGINEER.

From the Pro|ENGINEER top toolbar left-click

Create New File L. In the dialog box that
appears the default Type is Part, left-click
Drawing.

Enter the name of your robot. We will use
FTC_Robot.

Make sure Use default template is checked then

click o],

The New Drawing dialog opens.

7.

Your car assembly should be listed in the Default
Model field.

Make sure the Use template option is checked.

Select the paper size/temi late you wish to use for
the drawing then click

Pro|ENGINEER will create a drawing with drawing
border/format and three orthographic views

@ Note: The toolbar on the right of the screen has

changed to display the commands and options
relevant to drawing creation.

Tvpe Sub-tyoe
O 35 Skelsh

O ] Pan

O T] Aszsembly

O g, Mamfaciuing

(& [&] Drawing

O T Fomat

Mame F1C_Robaf
Ceenmen Mame

[#] Use dafaut template

Default Model

ROBOT_CLIMB.ASM

Specify Template
() Use template
) Empty with format
O Empty

Template

a3_drawing

Browse...

all_drawing
al_drawing
a2_drawing

a3 drawing
ad_landzcape
d_drawing
drawing_template

The views are too small so the scale of the drawing will be changed. Look in the bottom
left corner of the drawing area and you will see the current scale is set to a scale such as
0.167. This will be changed to 0.25




Changing the scale

10. Double click on the scale text at the
bottom of the drawing area.

11. A small dashboard will open in the
command prompt line (usually across
the top of the Pro|ENGINEER screen).

12. Alter the value to 0.25 then click on
v

& Enter value fior scale m

The views are now larger and the scale text
shows the new value.

The three orthographic views are currently shaded and need to be changed to hidden line
removal to comply with most international drawing standards.

Changing view properties

13. Left Click @ to select one of the
views. A red dashed outline will
appear to show it is selected.

14. Keep the mouse cursor over the
selected view then hold down Right-

click Ej until a floating menu appears.
15. From the floating menu select

Properties.
I Dvarving View
Categones Views display options
Wiew Trps
Wisbde Area
The Drawing View dialog opens. ook | Disey e | I ~
P— . e S| Targerk edges diiplay sde | T Sod -
16. In the Categories list select View T | s iesrerasd et —=
Display. Algrmerd | () s &) The dhaving
(& Ho (21 Thee model
17. Change the Display Style to No s ey bt s et
Hidden then click on to close o

the dialog. o

Hickdan bna rermosyal foi chabchas
& Yar HLR mdg= daplsy quakty
_:i: Mo Foboaw Errrapnmen i




The selected view will now display without
shading.

18. Use the same method to change the
properties of the other three views.

Adding centre lines

With three views in place we can add dimensions and annotations to the drawing. The
first step is to show the centre lines for the wheels.

19. From the Drawing toolbar across the top of the [ Show / Erase X)

Pro|ENGINEER screen, select Show/Erase rEE. This
will open the Show/Erase dialog box.

Sho |_e

Type

20. Inthe Type section of the Show/Erase dialog left-click ray 2

AXis | _____ A | L hBCD /—® | _____ Al
o S
&, - . . @
Note: Clicking on buttons in the Type section toggles
them On/Oﬁ: G)Sl'l]:?:;tii () Feature and Yiew

) Pat (O Part and View
OMiew [ Show 4l

21. Inthe Show By section make sure Feature is selected.

Options | Preview

22. Zoom in on one of the views. [ Erased
Mever Shaown

23. Move the mouse over one of the tires and, when the
cylindrical surface making up the tire pre highlights, click
to select the wheel.

Cloze

Pro|ENGINEER will create centre-lines
indicating the axes of the wheel revolve
feature.

24. Select each wheel in turn until all
wheels have centre lines.




Select Pz|

Select 1 or more items.

25. Inthe smaller Select dialog box select

(o)

This informs Pro|ENGINEER you have
finished your selections and will change the
options in the Show/Erase dialog.

26. Inthe Show/Erase dialog select

[teceptal ] followed by

[ Claze ] )

Pro|ENGINEER will have created centre-
lines in all 3 views.

Show I Erase Fz|

Tupe

Show By

Options

[ Sel ko Keep ][ Accept Al ]

[ Selto Remove ][ Eraze Al ]

To improve the aesthetics of the newly created centre-lines the length of the centre-lines

can be manually adjusted.

27. In the lower view select one of the
newly created centre-lines.

The centre-lines will now have drag handles
at each end.

28. Using these drag handles drag the
centre-lines to the required lengths,
and repeat this process for the other
centre-lines in this and the other
views.

Centre lines normally extend beyond the
model or main feature




Task two - Adding dimensions

The next step is to create dimensions. It is important to know the purpose of the drawing
which could be to manufacture a component, describe how to assemble the design or
check dimensional accuracy for quality control. For each of these the dimensioning
scheme would be different.

Pro|ENGINEER has the facility to import dimensions from the 3D model but for this
exercise we will create dimensions individually.

First you will dimension the width of the front wing.

Linear dimensions

1.

In the Drawing toolbar across the top of the screen select 1 the New
references... tool.

Zoom in on the plan view of the robot.

Move the mouse cursor over the
outside edge of one wheel X;. When
the edge pre-highlights in cyan, Left

Click O to select and the edge will
turn red.

Move the mouse cursor and click to
select the outside edge X, of the
opposite wheel to select it.

Move the mouse cursor into a clear
space away from the end of the robot
X3 and Middle mouse click @ to
locate the dimension text.

The dimension will be created.

Add another dimension for the overall
length of the robot.

Add any other linear dimensions you
need to communicate to the intended
audience.




Circle dimensions
9. Zoom in on the front view of the robot.

10. Move the mouse over one of the
wheels at X; and, when the outer edge

pre-highlights light blue, Left Click Ej
to select it.

11. Move the mouse to where you want
the dimension text to appear X, and

Left click Cj

A radius dimension will be created.

12. Move the mouse over the other wheel at X3 and, when the outer edge pre-highlights
light blue, Double left Click Cjto select it.

13. Move the mouse to where you want the dimension text to appear X4 and Left click

O

A diameter dimension will be created.

Task three — Pictorial view

Additional views can be added at any time. In the steps that follow we will insert an
Isometric shaded view to the drawing.

1. Open the Insert pull-down menu, select Drawing -———_@

View then click on General. (S —

MHa Cambined State

The Select Combined State dialog opens. DEFAULT ALL

2. Make sure No Combined State is selected then

click [L0K_],

[ Do not prompt for Combined State

Cancel )l

The prompt area at the top of the screen is prompting you to Select CENTER POINT for
drawing

3. On the drawing, click where you want the view. For example in the blank area above
the title block.




4. The Drawing View dialog opens and

the view previews in the drawing. Calegoies e ype
. . . i wa | WE name | nes_visw_d
5. Inthe Categories dialog View Type st | 1ioe
should be selected. e e [T
. . 'E"“‘P“W Select orieniafion method (%) Views names from the moded
6. Inthe list Model view names scroll end © Goomety efvences
and select ISOMETRIC. ptve ke
- . . |SOMETRIC Trmsliie =
7.  Click Apply to preview the changes in BALK Al e
. BOTTOM
the drawing. FRONT ¥ angle
. . LEFT
8. Click close the dialog. RIGHT v
Clagi

The Isometric view will appear in the
drawing.

Task four - Adding notes

The note tool in Pro|[ENGINEER allows you to add text to the drawing. We will use it to fill-
in the title block.

1. Zoom in on the title block in the bottom right hand corner of the drawing.

Notice some information has been entered for you automatically. This includes the

drawing number from the filename and the drawing scale. Pro|ENGINEER can automate
far more.

We will edit an existing, empty note and then add a note manually.

Edit an existing note

2.  Move the mouse inside the TITLE rectangle and when it pre-highlights click to select
it.

The outline will turn red.




3. Keep the mouse cursor inside the
selected rectangle then click and hold oy
the right mouse button. FTEFebel (Som ]
From the floating menu select Properties. [ Osee.
The Note Properties dialog opens.
4. Under the Text tab, delete any text
and type in FTC Robot.
Hyperbnk. . J
5. Click on .
The title block will now contain your text.
Adding a note manually
We will create two lines of text inside the large rectangle in the toolbar.
6. Open the Insert pull-down text menu and select Note... P —
A NOTE TYPES menu manager dialog will open on the right of PES
the screen. :
. . . . With Leader
Selections are made in each section working from top to bottom. 150 Leader
on Ikem
OFfset

7. We will use the defaults so at the bottom click on Make s

Note.

Horizontal

Yertical

Angular

Standard

The prompt at the top of the screen is telling us to:
g Seleck LOCATION For note. -
=]
Cenker
Right

8. Locate the large rectangle in the title block.
9. Click near the top left corner of this rectangle X; to style ”T
Cur Skyle

establish the start point for the text. ke Nt

DonefReturn

The prompt area at the bottom of the screen is waiting for you to type text for the note.
& Enter NOTE: Pro/ENGIMEER =
10. Type in the name of your team, we have used Pro/ENGINEER.

11. Left Click @ once on the check mark in the prompt line to close this line and
open a second line for text.




12. In the prompt line, type the second line of text. We have used Assembly.

% Enter NOTE: &gsembly | %

13. Left Click E3twice on the check mark to finish entering text.
14. The text will appear in the title block.

This briefing is now complete.




Briefing nine — presentation images

If you would like to learn about rendering, PTC’s schools curriculum contains projects
covering rendering including:

e Periscope
e F1in Schools D Type
e Scalextric4Schools

Key principles

The Advanced Rendering Extension (ARX) module in Pro|[ENGINEER is very powerful
with many adjustments possible to the room environment such as materials, lighting,
reflections, etc possible.

This session will provide a brief overview and hands-on experience of just a few features,
enough to produce a final rendered image of the CO, car assembly.

The sequence you will work through is:
e Open an assembly of the FTC robot assembly
e Define initial render settings
e Load a scene definition
e Position the model in the room
e Change view of model
e Try an initial render
e Perform the final render
e Save the rendered image

Task one - Getting started

1. Log-on and start Pro|[ENGINEER

2.  Set the working directory to: \FTC_Robot\Slope climb
3. Openthe model ROBOT_CLIMB.ASM

The robot parts should already have an appearance similar to real materials.

As you work through the rest of this section you will notice objects look even more like the
material they would actually be made of.
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Task two - Initial render

Open the render toolbar

1. Inthe Main toolbar across the top of the screen,
open the View pull-down menu and select
Realtime Rendering.

2. In ablank area of the main toolbar, hold down the
Right mouse button Ej and from the floating
menu, select Render.

The render toolbar appears in the main toolbar across

the top left of the screen.

DB AREKEe QS

St
w 4

: 4

= 2

-

K

In the Render toolbar click on the Scenes button
e

In the Scenes dialog scroll to select the sky-
studi entry and double click to apply it to the
model.

Check the option to Save scene with model.

Click to close the dialog

A scene applies several parameters to the model
in step including room size and shape, light
settings, etc.

The graphics window will display a simple
representation of the rendered view including shadows
and reflections.

To see a higher quality view a number of options need
to the changed.

FIRST Tech Challenge

Top Toolchest

Analysis
Annotation

Base Features

Datum

v Datum Display

v Edit
Edit Features

Engineering Features

v File
v Help
Info

v Model Display
v Render

File Edit

skystudi |

Save scene with model

~

[ Close

] [ Preview >>> ]
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Floor position

8.

10.

In the Render toolbar, select the Room Editor

button @

In the Room Editor dialog, click to snap the

floor to the model.

Click on to close the Room Editor dialog.

Render settings

11.

12.

13.
14.
15.

16.

In the Render toolbar, click on 2 1o open the

floating Render Control toolbar.

In the Render Control toolbar, click on @ to
open the Render Setup dialog.

Makes sure the Renderer is set to Photolux.
Change the Quality option to Maximum.

Change the other options to those shown here.

Click on to close the Render Setup
dialog.

FIRST Tech Challenge

E Room Editor El 0 El

Fie  Room

FRoom Appearances

||
|
|

[#] Lock Rioom to Model

Pesition | Rotate | Display
Size

Ceing [T 3000 | | ko

T (a1

W

Renderer | Photolx

Guality | b aximum w

Options |Adv Output | Config
Ray Trace

Bounces(3 3]

todel
Shadows
Reflective

&) Room

) Background

) Enviranment

) Nane

Roam
Fender Room
Light Fioom
Shadows
Reflective

[ Ceiing

Flaor

[Jwaln
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Task three — Final render

1. Select the Render icon @ from the
Rendering Toolbar.

You will see the Render Abort dialog
displaying progress. After a few moments,
or perhaps a few minutes on slower
computers, you will see the rendered image
of your robot.

Congratulations, you have just created your
first rendering!

On a fairly quick Dell PC with Dual Core
processor and 2GB RAM, this draft render
took around 3 minutes and used over 50%
of the two processors resources for that
time.

This shows the level of math computation
needed to calculate the light paths, surface
reflections and effects.

Experiment with the position and render each time until you are happy with the final image.

When you are happy with all the settings, change the quality to Maximum and render the
model. You will probably have time for a leisurely drink...

Save rendered image

If you want a quick copy of the rendered mode you I= Render Setup (=13

could capture and crop the screen display. Renderer | Photolux v
Quality | Maximum v

Pro|ENGINEER provides the option to create rendered —_— T T

images in several different formats and at higher Dutput

resolutions than the screen. RenderTo T4 —

File Name |3lope climb\Slope_slip\untitied tif
Preview [[] Show Image Boundary

2. Click @ in the Render toolbar or click View >
Model Setup > Render Setup to open the

Image Size

[ v
Render Setup dialog. s Cust
Click the Output tab. widh (1280
Change the Render To option to Tiff or an image Height 1024

format of your choice.

Postscript O

5. Afile name with the appropriate extension appears
in the File Name box. Edit this giving the file a
name you will remember.




Change the image Size to Custom.
Alter the Width & Height until the border surrounds your model.
Hold down shift and drag with the MMB to position the model in the frame.

© © N o

Close the Render Setup dialog.

10. In the Render toolbar click on ﬁ to render the model.
11. The image with be saved with the required file name.

A Tiff image file has been created in the working directory of the rendered model
12. Save your model, exit Pro|ENGINEER.

This briefing is now complete.




Extension one — Position encoding

Knowing the rotational position of an axel is very important in robotics and sensors are
available that will do this. One of the principles used is a version of the binary counting
system called ‘Gray’ scale where the binary ‘bits’ only change one at a time.

For more information on rotary encoding go to: http://en.wikipedia.org/wiki/Rotary encoder



http://en.wikipedia.org/wiki/Rotary_encoder

Pro|ENGINEER Wildfire 4 FIRST Tech Challenge

Extension two — Structural analysis

Schools Edition/Schools Advanced Edition - Loads, stress-strain, Young’s modulus,
deflection, yield, failure
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Appendix one - Web links

Carnegie Melon University - Robotics Academy

Self Assembly robots

Caterpillar — robotic mine trucks

Prosthetic arm — Dean Kamen

Robotic arm
Mechatronics
Mars rover — BBC article

Exoskeleton

FIRST team — Trobotics - 1346

Lunar habitat hauler

ProlENGINEER designed Twendy robot
Reliable mars rover — Futures channel

Carnegie Mellon Robotics Institute

Nuvo robot

Twendy-one
Technogames

D:\PTCData\AA ProE\AA Curriculum\02 High School\02 09 Robotics\FTC\FTC_Robotics.doc



http://www.education.rec.ri.cmu.edu/content/curriculum/middle_school/sub_page_1/index.htm
http://www.boingboing.net/2009/01/29/robot-reassembles-it.html
http://industryweek.com/articles/caterpillar_and_bhp_billiton_to_build_robotic_mine_trucks_16895.aspx
http://www.boston.com/business/globe/articles/2007/10/07/inventor_seeks_ways_to_make_lives_whole/?page=2
http://www.thefutureschannel.com/dockets/science_technology/testing_robotic_hand/
http://www.projectmechatronics.com/
http://news.bbc.co.uk/1/hi/sci/tech/7397951.stm
http://www.usatoday.com/tech/news/techinnovations/2008-05-15-robotic-suit-iron-man_N.htm
http://trobotics.ca/#Home
http://www.popsci.com/military-aviation-space/article/2008-04/lunar-habitat-hauler
http://www.ptc.com/appserver/wcms/standards/free.jsp?&im_dbkey=83999&icg_dbkey=21
http://www.thefutureschannel.com/dockets/hands-on_math/reliable_robots/
http://www.ri.cmu.edu/
http://nuvo.jp/nuvo_home_e.html
http://twendyone.com/demo_e.html
http://www.bbc.co.uk/science/robots/techlab/sub_showcase.shtml

Pro|ENGINEER Wildfire 4 FIRST Tech Challenge

Appendix two — Servo motor specification

Detailed Specifications
Control Svstenm: +Pulse Wicdth Cortrol 1S00usec Neutral
Required Pulse: 3-5 Volt Peak to Peak Square Wave
Operating Voltage: 4 8-6 0 Yolts
Operating Temperature Range: -20to +680 Degree C
Operating Speed (4.8V): 0.23sec/50° at no load
Operating Speed (6.0V): 0.18sec/50° at no load
Stall Torque (4.8V): 61 oz/in. (4.3kg.cm)
Stall Torque (6.0V): 76 oz/in. (5.5kg.cm)
Operating Angle: 45 Deg. one side pulse traveling 400usec
360 Modmfiable: Yes
Direction: Clockwise/Pulse Traveling 1500 to 1900usec
Current Drain (4.38V): 8mAjdle and 1 50m& no load operating
Current Drain (6.0V): 8 8mAjdle and 180ma no load operating
Dead Band Width: Susec
Motor Type: 3 Pole Ferrite Motor
Potentiometer Drive: Indirect Drive
Bearing Type: Top Ball Bearing, Lower Bushing
Gear Type: Karbonite Gears
Connector Wire Length: 11.81" (Z00mm)
Dimensions: See Schematic
Weight: 1 40z (39q)
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Appendix three — DC geared motor specification

TETRIX DRIVE MOTOR
Dyvnhamic Test Report

Product: ~ DC Gear Motor Rated Voltage: 12 VDC
Customer: Pitsco No Load Speed: 154 RPM
Mode NO.: HG372F280-052F No Load Current: 0.428 A
Test Date: 2008/05/12 Gear Ratio: 1.52

(A} Dimensional Figures:

40
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el 1§

s [T .

L

o
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=B5 _an
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(B} MOTOR PERFORMANCE CURVES AND CHARACTERISTICS: Supply Voltags = 12 vDC
ATNGLOAD
- SPEED = 1387 APM
CURRENT = 054 AMP
-
35 7 AT STALL EXTRAPOLATION
b TORQUE = 23.40 kgcm
1 T CURRENT = 7.30 AMP
7 5
20 4
AT MAXIMUM EFFICIENCY
LE -
x z ¢ B EFFICIENCY = 27.74 %
b oisd5 sd% - 100 = SPEED = BBO RPM
i § 5 J_:ﬁ TORQUE = 977  kg<m
o 4" CURRENT = 275 AMP
10 QUTPUT = 9.06 WATTS
2 ] |
B 50 4
AT MAXIMUM QUTPUT
4 SPEED = 761 RPM
TORQUE = 1181 kg<cm
: 11 CURRENT = 3.32 AMP
o o g - ullll:llll:lllﬁ:llll:ll\‘\i OUTPUT = 938 WATTS
o 5 1w 18 a0 EFFICIENCY = 27.01 %
Torgus | kgoom |
Torque Commersions:
1.0 kgl-cm = 0.098 Nm = 88 miNm
= 13,887 oz-in = 0.867 lb-in
PREPARED BY: APPROVED BY:
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